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Introduction

Welcome to Windows 8.1 on Demand, a visual quick refer-
ence book that shows you how to work efficiently with 
Windows 8.1.  This book provides complete coverage of 
basic to advanced Windows skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Windows 8.1, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in Windows 8.1. A com-
plete description of each new feature appears in the New
Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P, as a quicker alternative to using the mouse. A com-
plete list of keyboard shortcuts is available on the web at
www.queondemand.com or www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Get More on the Web

http://www.queondemand.com
http://www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the web at
www.queondemand.com or
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

http://www.queondemand.com
http://www.perspection.com


The Workshops
walks you
through in-depth
projects to help
you put Windows
8.1 to work.

Introduction xix

Additional content 
is available on the
web. You can
download a
document of
keyboard shortcuts.

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the web at
www.queondemand.com or
www.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up to speed faster with
Windows 8.1. Some of the infor-
mation includes: 

Transition Helpers
◆ OOnnllyy  NNeeww  FFeeaattuurreess..

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ KKeeyybbooaarrdd  SShhoorrttccuuttss..

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

http://www.queondemand.com
http://www.perspection.com


xx

More Content
◆ PPhhoottooggrraapphhss.. Download

photographs and other
graphics to use in your Office
documents. 

◆ MMoorree  CCoonntteenntt.. Download
new content developed after
publication. 

You can access these additional
resources on the web at
www.perspection.com.

Download and
use Photographs
to help you add
impact to your
documents.

http://www.perspection.com


Managing Files and Folders

Introduction

File management is organizing and keeping track of files and
folders, helping you stay organized, so information is easily
located. A ffoollddeerr is a container for storing programs and files,
similar to a folder in a file cabinet. As with a file cabinet,
working with poorly managed files is like looking for a needle
in a haystack—it is frustrating and time-consuming to search
through irrelevant, misnamed, and out-of-date files to find
the one you want. Windows allows you to organize folders
and files in a file hierarchy, imitating the way you store paper
documents in real folders. Just as a file cabinet contains sev-
eral folders, each containing related documents with dividers
grouping related folders together, so the Windows file hierar-
chy allows you to organize your files in folders, and then
place folders in other folders. File Explorer comes with four
libraries: Documents, Music, Pictures, and Videos. Libraries
are special folders that catalog folders and files in a central
location. A library includes and displays folders that are
stored in different locations on your PC computer,
Homegroup, or network. 

Using the file management tools, you can save files in
folders with appropriate names for easy identification,
quickly and easily create new folders so you can reorganize
information and delete files and folders that you no longer
need. You can also search for a file when you cannot remem-
ber where you stored it, create shortcuts to files and folders
for quick and easy access, and even compress files and fold-
ers to save space.

A folder can hold different types of files, such as text,
spreadsheets, and presentations. The Documents folder is the
main location in File Explorer where you store your files.
However, there are some special folders, such as Pictures and
Music, designed with specialized features to store specific
types of files.

3

3
What You’ll Do

Use the Explorer Window

Change the Explorer Window View

Use the Ribbon and Choose Commands

Open and View This PC

Work with Libraries

Navigate Between Folders

View the Folders List

Customize the Navigation Pane

Organize, Sort, and Group Files

Search for Files and Folders

Add Properties and Tags to Files

Create and Rename Files and Folders

Copy and Move Files and Folders

Delete and Restore Files and Folders

Create a Shortcut to a File or Folder

Change Folder Options

Change File and Folder List Views

Customize Personal Folders

Share Folders or Files with Others

Compress Files and Folders

Manage Files Using a CD or DVD

47



48 Chapter 3

Explorer windows, such as File Explorer, are
powerful easy-to-use tools for working with
files in the desktop in Windows 8. Explorers
give you more information and control while
simplifying how you work with your files. The
experience is easy and consistent, whether
you're browsing documents or photos or
even using the Control Panel. Key elements of
the Explorer windows in the desktop are
designed to help you get to the information
you need, when you need it. Each Explorer
window includes the following elements:

◆ TToooollbbaarr.. Use to access frequently used
commands, known as the Quick Access
Toolbar.

◆ RRiibbbboonn.. Use to access buttons or options
organized in groups on tabs.

◆ BBaacckk,,  FFoorrwwaarrdd,,  aanndd  UUpp  bbuuttttoonnss.. Use to
navigate between previously viewed
folders.

◆ AAddddrreessss  bbaarr.. Use to navigate directly to a
different location, including local and
network disks, folders, and web
locations.

◆ SSeeaarrcchh  bbooxx.. Use to perform instant
searches, which show only those files
that match what you typed in the Search
box for the current folder and any of its
subfolders.

◆ NNaavviiggaattiioonn  ppaannee.. Use to display common
folders, such as Favorites, SkyDrive
(New!), Homegroup (a shared network),
This PC (New!), and Network, using a
Folder list tree structure.

◆ SSkkyyDDrriivvee,,  TThhiiss  PPCC,,  oorr  LLiibbrraarriieess.. Use to
access common folders, such as
Documents, Music, Pictures, and Videos
located on your SkyDrive (New!) on the
Microsoft cloud, or local PC (New!). A
library is a collection of files and folders
linked from different locations—such as a
SkyDrive or This PC by default—into a
central place. A file or folder can be
stored in one location, yet linked to a
library for easy access in one place.

◆ SSttaattuuss  bbaarr.. Displays number of items and
selected items in a folder, and Details and
Icons view buttons.

Using the Explorer Window

Navigation
pane Folder list

Address barTabs

Back, Forward,
and Up buttons

Search box

Status bar

Toolbar
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The Explorer window displays the contents of
a drive or folder in different ways to help you
find the information you are looking for about
a file or folder. The available views on the
View tab of an Explorer window include Extra
Large, Large, Medium and Small Icons, List,
Details, Tiles, and Content. 

IIccoonnss view displays icons in different sizes
(Extra Large, Large, Medium, and Small),
sorted alphabetically in horizontal rows with
the name of the file or folder below each icon.
When you view files using one of the Icon
views, Live icons—thumbnails—display the
first page of documents, the image of a
photo, or the album art for individual songs,
making it easier to find exactly what you are
looking for.

LLiisstt view displays small icons, sorted alpha-
betically into vertical columns with the name
of the file or folder next to each icon. 

DDeettaaiillss view displays small icons, sorted
alphabetically in a vertical column with the
name of the file or folder and additional infor-

mation, such as file size, type, and date, in
columns to the right.

TTiilleess view displays icons, sorted alphabeti-
cally into vertical columns, with information
about the file next to each icon.

CCoonntteenntt view displays medium icons in a ver-
tical column with date modified information.

Switching Between Views
You use the Layout options on the View tab in
an Explorer window to quickly switch
between window views. When you point to a
Layout option—such as Extra large icon,
Large icon, Medium icons, Small icons, List,
Details, Tiles or Content—on the View tab, File
Explorer displays a live preview of the option
change so that you can see exactly what your
change will look like before committing to it.
You can also quickly change between Details
and the current icons view by using the
Details View and Icons View buttons on the
Status bar.

Changing the Explorer Window View

Views button

View buttons on Status bar

Live icons
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The RRiibbbboonn is a results oriented way of work-
ing in File Explorer. The Ribbon is located at
the top of the window and is comprised of
ttaabbss that are organized by task or objects. The
controls on each tab are organized into
ggrroouuppss, or subtasks. The controls, or ccoomm--
mmaanndd  bbuuttttoonnss, in each group execute a com-
mand, or display a menu of commands or a
drop-down gallery. Controls in each group
provide a visual way to quickly make docu-
ment changes. The File tab on the left side of
the Ribbon displays a menu of files related
commands.

TIMESAVER To minimize the Ribbon,
click or tap the Minimize the Ribbon
button (Ctrl+F1) or double-click or
double-tap the current tab. Click or tap a
tab to auto display it (Ribbon remains
minimized). Click or tap the Expand the
Ribbon button (Ctrl+F1) or double-click
or double-tap a tab to maximize it.

If you prefer using the keyboard instead 
of the mouse to access commands on the
Ribbon, File Explorer provides easy to use
shortcuts. Simply press and release the 7 or
j key to display KKeeyyTTiippss over each feature in
the current view, and then continue to press
the letter shown in the KeyTip until you press
the one that you want to use. To cancel an
action and hide the KeyTips, press and
release the 7 or j key again. If you prefer
using the keyboard shortcuts found in previ-

ous versions of Windows, such as Ctrl+C (for
Copy) and Ctrl+V (for Paste), all the keyboard
shortcuts and keyboard accelerators work
exactly the same in File Explorer.

Tabs
File Explorer provides three types of tabs on
the Ribbon. The first type is called a ssttaannddaarrdd
tab—such as File, Home, Share, and View—
that you see whenever you use File Explorer.
The second type is called a ccoonntteexxttuuaall tab—
such as Library Tools, Picture Tools, or Video
Tools—that appears only when they are
needed based on the type of task you are
doing. File Explorer recognizes what you’re
doing and provides the right set of tabs and
tools to use when you need them. The third
type is called a pprrooggrraamm tab that replaces the
standard set of tabs when you switch to cer-
tain views or modes, such as Homegroup,
This PC, or Network.

Live Preview
When you point to some options, such as a
Layout option—Extra large icon, Large icon,
Medium icons, Small icons, List, Details, Tiles
or Content—on the View tab on the Ribbon,
File Explorer displays a live preview of the
option change so that you can see exactly
what your change will look like before com-
mitting to it.

Using the Ribbon

Standard tabs Contextual tabKey Tip Minimize the Ribbon button



Chapter 3 Managing Files and Folders 51

File Explorer commands are organized in groups on the Ribbon and
Quick Access Toolbar. Commands are available as buttons or options on
the Ribbon, or as menus on button or option arrows or the File tab. The
Quick Access Toolbar displays frequently used buttons that you may be
already familiar with from other Microsoft programs, while the File tab
on the Ribbon displays file related menu commands. In addition to the
File tab, you can also open a shortcut menu with a group of related
commands by right-clicking or tap holding an element.

Choosing Commands

Choose a Menu Command Using 
the File Tab

In File Explorer, click or tap the
File tab on the Ribbon.

If the command is followed by an
arrow, point to the command to
see a list of related options. 

Click or tap a command. 

TIMESAVER You can use a
shortcut key to choose a
command. Press and hold down
the first key and then press the
second key. For example, press
and hold the Ctrl key and then
press W (or Ctrl+W) to select the
Close command.

Choose a Menu Command from 
a Shortcut Menu

In the desktop or File Explorer,
right-click or tap-hold an icon.

TIMESAVER Press Shift+F10 to
display the shortcut menu for a
selected command. 

Click or tap a command on the
shortcut menu. If the command is
followed by an arrow, point to the
command to see a list of related
options, and then click or tap the
option you want.

2

1

3

2

1

1
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3

2
Frequently used folders Pin to File menu
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The This PC window is the starting point to access every disk, folder,
and file on your PC computer. You can access the This PC window from
File Explorer. The This PC window displays local folders (New!) and
several types of local, removable, and network drives. Drives and fold-
ers are represented by icons. Each drive is assigned a drive letter,
denoted with parentheses and a colon, such as Local Disk (C:), to make
it easier to identify. Typically, the floppy is drive A, the hard (also known
as local) disk is drive C, and the CD or DVD is drive D. If your PC com-
puter includes additional drives, your PC computer assigns them letters
in alphabetical order. Once you open more than one drive or folder, you
can use buttons on the Ribbon to help you move between folders. 
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Opening and Viewing
This PC

Open and View This PC

In the desktop, click or tap the File
Explorer icon on the taskbar. 

Click or tap This PC (New!) in the
Navigation pane.

◆ In the Start screen, you can
also click or tap Apps view
button, and then click or tap
This PC.

TIMESAVER Press Win+E to
display the This PC window. 

Click or tap a drive to select it.  

To review the drive details, click or
tap the Details pane button on the
View tab. 

Double-click or double-tap the
drive to open it.

Click or tap the Back or Forward
button or the Up button on the
toolbar to return or move to a
previously visited window.

TIMESAVER You can press the
Backspace key to go back to a
previous folder you visited.

When you’re done, click or tap the
Close button.

7
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2

76

Details pane

3 54



Chapter 3 Managing Files and Folders 53

See Also
See “Changing the Explorer Window
View” on page 49 for information on
changing the display of a folder’s 
contents.

Did You Know?
You can add the Computer icon to the
desktop. In the desktop, right-click or
tap-hold the desktop in a blank area,
click or tap Personalize, click or tap
Change Desktop Icons in the left pane,
select the Computer check box, and
then click or tap OK.

You can find Windows system infor-
mation in This PC. In File Explorer, click
or tap This PC in the Navigation pane,
click or tap System Properties on the
Computer tab. You can also right-click
or tap-hold the lower-left corner, and
then click or tap System, or press
Win+Pause/Break.

You can find drive or device properties
in This PC. In File Explorer, click or tap
This PC, click or tap the drive or
device, click or tap Properties on the
Computer tab.

Icon Type Description

Local A hard magnetic disk (or hard disk) on which you can store 
large amounts of data. The Local Disk (C:) stores all the 
files on your PC computer.

Floppy A soft removable magnetic disk that comes in a 3½-inch 
size, which stores up to 1.44 MB of data. Floppy disks are 
slower to access than a hard disk, but are portable and 
much less expensive.

Removable A removable magnetic disk on which you can store 
PC computer data, such as a Zip disk (requires software). 
Another is a Flash memory card the size of a large stamp 
that holds128, 256, 512 MB or greater. Flash drives connect 
directly into a USB plug without software.

CD-ROM Compact Disc-Read-Only Memory An optical 
disk on which you can stamp, or burn, up to 1 GB (typical 
size is 650 MB) of data in only one session. The disc 
cannot be erased or burned again with additional new 
data.

CD-R Compact Disc-Recordable A type of CD-ROM 
on which you can burn up to 1 GB of data in multiple 
sessions. The disc can be burned again with new data, 
but cannot be erased.

CD-RW Compact Disc-Rewriteable A type of CD-ROM on which 
you can read, write, and erase data, just like a hard disk.

DVD Digital Video Disc A type of DVD-ROM that holds a 
minimum of 4.7 GB, enough for a full-length movie.

DVD-R Digital Video Disc-Recordable A type of DVD-ROM on 
which you can burn up to 4.7 GB of data in multiple 
sessions. The disc can be burned again with new data, but 
cannot be erased.

DVD-RW Digital Video Disc-Rewriteable A type of DVD-ROM on 
which you can read, write, and erase data, just like a hard 
disk.

HD-DVD High Density Digital Video Disc A type of high density
DVD-ROM on which you can read data; the disc appears as a high 

density drive.

Blu-ray High Density Blu-ray Disc A type of high density DVD-
ROM on which you can read data; the disc appears as a 
high density drive.

Typical Disk Drives on a Computer



Windows makes it easy to manage the personal and business files and
folders you work with every day. You can access your Documents
folder from File Explorer, which displays the Documents library folder.
The Documents library folder links and displays files and folders from
different locations on your PC computer and SkyDrive in a central
place, which includes your Documents folder located in your personal
folder. In the folder, you can view file information, organize files and
folders, and open files and folders. Once you open more than one
folder, you can use buttons to help you move quickly between folders.
Depending on previous installation, devices installed, or other users,
your personal folders might differ. 
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Viewing and Opening
Documents

View and Open Documents

In the desktop, click or tap the File
Explorer icon on the taskbar. 

Click or tap Document in the
Navigation pane.

Double-click or double-tap a folder
to navigate to the document
location.

Click or tap the document file to
select it.  

To review document details, click
or tap the Details pane button on
the View tab. 

To open the document file, double-
click or double-tap the file icon.  

When you’re done, click or tap the
Close button.
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Did You Know?
Windows creates a separate
Documents folder for each user.
When you share a PC, Windows cre-
ates a separate Documents folder and
stores personalized settings for each
user. Each user’s Documents folder is
located in the Documents And Settings
folder under the user’s name on the
local hard disk. 

5

2
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Open Any Folder and Switch
Between Folders

In the desktop, click or tap the File
Explorer icon on the taskbar. 

Click or tap any other Explorer
window, such as Documents,
Videos, Pictures, or Music, in the
Navigation pane.

Double-click or double-tap the
folder to open it.

Click or tap the Back or Forward
button or the Up button on the
toolbar to return or move to a
previously visited window.

When you’re done, click or tap the
Close button.

5
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See Also
See “Changing the Explorer Window
View” on page 49 for information on
changing the display of a folder’s 
contents.
See “Working with Libraries” on page
56 for information on using and creat-
ing libraries.

Did You Know?
Windows stores music and picture
files in separate folders in your 
personal folder.  Windows stores
music files in the Music folder and pic-
tures in the Pictures folder in your per-
sonal folder, which you can access
from the Music and Pictures libraries. 

Opening a Document with a Different Program
Most documents on your desktop are associated with a specific pro-
gram. For example, if you double-click or double-tap a document
whose file name ends with the three-letter extension “.txt,”
Windows automatically opens the document with Notepad, a text-
only editor. There are situations, though, when you need to open a
document with a program other than the one Windows chooses, or
when you want to choose a different default program. For example,
you might want to open a text document in WordPad rather than
Notepad so that you can add formatting and graphics. To do this,
right-click or tap-hold the document icon you want to open, point to
Open With, and then click or tap the application you want to use to
open the document, or click or tap Choose Program to access more
program options. Once you open a text file using WordPad, this
option is automatically added to the Open With menu.

For Your Information

2
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Libraries are special folders that catalog folders and files in a central
location. A library includes and displays folders that are stored in differ-
ent locations on your PC computer, SkyDrive, Homegroup, or network.
File Explorer comes with four libraries: Documents, Music, Pictures, and
Videos. The Documents library, for example, includes files and folders
from your Documents—This PC and SkyDrive (New!)—folders, which
are actually stored in your Users folder. Instead of navigating to sepa-
rate folders, you can quickly navigate to one central place, the
Documents library. You can create additional libraries at any time and
include folders from different locations or remove them. After you open
a library, you can arrange all files and folders included in a library by
folder (the default) or other properties based on the library type
(General Items, Documents, Music, Pictures, or Videos). When you save
a file to a library, you can specify which folder it actually gets stored in.

Working with Libraries

Open and View a Library

In the desktop, click or tap the File
Explorer button on the taskbar.

To show libraries, click or tap the
Navigation pane button on the
View tab, and then click or tap
Show libraries (New!).

Click or tap a library folder in the
Navigation pane or double-click or
double-tap a library folder.

To change the library display,
right-click or tap-hold a blank
area, point to Arrange by, and then
click or tap an option. 

◆◆ Folder. File and folders.
◆◆ General Items. Date modified,

Tag, Type, or Name.
◆◆ Documents. Author, Date

modified, Tag, Type, or Name.
◆◆ Pictures. Month, Day, Rating, or

Tag.
◆◆ Music. Album, Artist, Song,

Genre, or Rating.
◆◆ Video. Year, Type, Length, or

Name.
◆◆ Clear changes. Clears any

arrange by modifications.
To sort or group items, click or tap
the Sort by or Group by button on
the View tab, and then click or tap
an option. 
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Create a New Library and
Include or Remove Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the Libraries in the
Navigation pane.

Click or tap the New item button
on the Home tab, click or tap
Library, type a library name, and
then press Enter.

◆ To delete a library, select it,
click or tap the Delete button
on the Home tab, click or tap
Permanently delete, and then
click or tap Yes.

To include a folder in a library,
navigate to the folder location,
click or tap the Easy access button
on the Home tab, point to Include
in library, and then select the
library you want.

To remove a folder from a library,
open the library, click or tap the
Manage library button on the
Manage tab, select the folder you
want to remove, click or tap
Remove, and then click or tap OK.

5

4

3

2

1

3 New library

Did You Know?
You can change the save location.
Open the folder you want to change
the save location, click or tap the
Manage tab, click or tap the Set save
location button, and then select a
folder location. A check mark appears
to the left of the selected folder 
location.

4

2
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File Explorer comes with a personal folder that stores your most fre-
quently used folders in one location. The personal folder appears in File
Explorer with the name of the person logged on to the PC computer. The
personal folder only contains files and folders associated with a user
account and are unique for each user. The personal folder includes a
variety of folders: Contacts, Desktop, Downloads, Favorites, Links,
Documents, Music, Pictures, Videos, Saved Games, Searches, and
SkyDrive (New!). You can access these folders using the personal
folder from File Explorer under Desktop. The Documents, Pictures,
Music, and Videos folders are included in the Documents, Pictures,
Music, and Videos libraries respectively, so you can also access them
by name in File Explorer.

Working with 
Personal Folders

View and Open a Personal
Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the Desktop in the
Navigation pane.

Double-click or double-tap the
folder with the user account’s
name to open it.

Double-click or double-tap a folder
to open it.

When you’re done, click or tap the
Close button.
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The Address bar appears at the top of every Explorer window and dis-
plays the current location on your PC computer, skyDrive, or network.
The location appears as a series of links separated by arrows. You can
change your current location by either typing a new location—even a
web address on the Internet—or selecting one using the Address bar.
You can also use the Back and Forward buttons to the left of the
Address bar to switch between locations you have previously visited.

Navigating Between
Folders

Navigate to a Location

◆ Click or tap a location. Use either
of the following methods:

◆ Visible folder location. To go
directly to a location visible in
the Address bar, click or tap the
location name.

◆ Visible subfolder location. To
go to a subfolder of a location
visible in the Address bar, click
or tap the arrow to the right,
and then click or tap the
location name.

◆ Type a location. Click or tap a
blank space (to the right of text) in
the Address bar, and then type the
complete folder name or path to
the location, and then press Enter. 

You can type common locations
and then press Enter. The common
locations include: This PC,
Contacts, Control Panel,
Documents, Favorites, Games,
Music, Pictures, Recycle Bin, and
Videos.

If you type a web address (URL) in
the Address bar, the Explorer
window switches to Internet
Explorer. 

Address barClick a location

Navigation pane
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Windows offers a useful feature for managing files and folders, called
the Folders list, which is integrated under categories—Favorites,
SkyDrive (New!), Homegroup, This PC (New!), Libraries, and
Network—into the Navigation pane. The Folders list displays the win-
dow in two panes, or frames, which allows you to view information from
two different locations. The Navigation pane displays the file hierarchy
of all the drives and folders on the PC computer, and the right pane dis-
plays the contents of the selected drive or folder. This arrangement
enables you to view the file hierarchy of your PC computer and the con-
tents of a folder simultaneously making it easy to copy, move, delete,
and rename files and folders. Using the non filled arrow and the filled
arrow to the left of an icon in the Folders list allows you to display dif-
ferent levels of the drives and folders on your PC computer without
opening and displaying the contents of each folder.

Viewing the 
Folders List

View the Folders List

In the desktop, click or tap the File
Explorer button on the taskbar.

Open any folder window.

In the Navigation pane, point to an
item to display the navigation
arrows.

Perform the commands you want
to display folder structure and
contents:

◆ To show the file and folder
structure, click or tap the non
filled arrow.

◆ To hide the file and folder
structure, click or tap the filled
arrow.

◆ To display the contents of a
folder, click or tap the folder
icon.

4
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Did You Know?
You can quickly determine if a folder
contains folders. When an arrow 
doesn’t appear next to an icon in the
Folders list, the item has no folders 
in it.

Folder list tree structure



Chapter 3 Managing Files and Folders 61

File Explorer gives you the option to customize the layout for each
Explorer window depending on the information the window contains.
The layout for each Explorer window includes a Preview pane, Details
pane, and Navigation pane. The Preview pane provides a preview of
the selected item, such as a picture. The Details pane a thumbnail pre-
view and information about the selected item, such as the file name,
type, date modified, dimensions, size, and date created. The Navigation
pane provides a tree structure to navigate folders and drives on your
SkyDrive, This PC, or libraries. The Details and Navigation panes
appear by default. The Panes group on the View tab provides options to
show or hide the Explorer layout elements (New!). 

Changing the Explorer
Layout

Change the Explorer Layout

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder window you want
to change.

Click or tap the View tab.

Select the layout pane button you
want to show or hide: Preview
Pane, Details Pane, or Navigation
Pane (and then click or tap
Navigation pane).

Click or tap the Navigation Pane
button, and then click or tap an
option to show or hide items in the
Navigation pane: Show all folders,
Show libraries (New!), or Show
favorites.

Layout options vary depending on
the type of Explorer window.
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The Navigation pane provides links to commonly used drives and fold-
ers to reduce the number of clicks or taps it takes to locate a file or
folder. File Explorer provides a default list of favorites, libraries, home-
groups, and networks in the Navigation pane. You can customize the list
of favorites for your own purposes. You can move current links, add or
rename folders, or remove an item. If the Navigation pane gets clut-
tered, you can restore it back to the original default items. You can also
set Navigation pane options to show all folders like the Folder list and
automatically expand the folder list to the current folder. 

Customizing the
Navigation Pane

Customize the Navigation Pane
◆ Move a link. Drag an item in the

Navigation pane to a higher or
lower position in Favorites.

◆ Add a link. Drag an item from its
original location to a position in
the Navigation pane in Favorites.

◆ Rename a link. Right-click or tap-
hold the link in Favorites, and then
click or tap Rename. Type a new
name, and then press Enter. The
original folder or search is not
renamed, only the Navigation link.

◆ Remove a link. Right-click or tap-
hold the link in Favorites, and then
click or tap Remove. The original
folder or search is not removed,
only the Navigation link.

◆ Restore default links. Right-click
or tap-hold the Favorites link in the
Navigation pane, and then click or
tap Restore favorite links.

◆ Show all folders like the folders
list. Click or tap the Options button
on the View tab, click or tap
Change folder and search options,
select the Show all folders check
box on the General tab, and then
click or tap OK.

◆ Automatically expand the folder
list to the current folder. Click or
tap the Options button on the View
tab, click or tap Change folder and
search options, select the
Automatically expand to current
folder check box on the General
tab, and then click or tap OK.

Remove and Rename a linkFavorites in the Navigation pane

Navigation pane
folder options
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In Explorer windows, files and folders appear in lists with headings at
the top in Details view. You can use the headings to change how files
are displayed in the window. You can use filtering and sorting to display
the files and folders you want. Filtering displays only files and folders
with the properties you select by heading type. For example, the A - H
filter for file and folder names displays only files and folder that start
with A - H. Sorting displays the files and folders in ascending or
descending order by heading type. For example, the sort by name dis-
plays files and folders from A to Z or Z to A. You can apply a filter and
sort a column to achieve the results you want. 

Organizing Files by
Headings

Organize Files Using Filtering or
Sorting

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder that contains the
files you want to sort or filter.

Click or tap Details on the View
tab, or click or tap the Details
button.

To sort files by headings, click or
tap the heading title you want to
sort by. An arrow in the middle of
the heading indicates the sort
direction, ascending and
descending.

Point to the heading you want to
filter by.

Click or tap the arrow to the right
of the heading you want to filter
by.

Select the property check boxes
you want to filter by. 

Click or tap in a blank area to
close the search menu. 

A check mark replaces the arrow
to indicates a filter is in place. 

◆ To cancel the search, you can
also press Esc.
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In Explorer windows, files and folders appear sorted or grouped by dif-
ferent attributes, such as name or type, in the different views, such as
Icons (Extra large, Large, Medium, or Small), List, Details, Tiles, and
Content. You can select the attributes you want to use and then select
whether to display the files and folders in ascending (A-Z) or descend-
ing (Z-A) order. You can use the Sort by or Group by buttons on the
View tab to specify the options you want to apply to the current folder.
The Sort by and Group by options are the same. However, the available
options vary depending on the selected folder type, such as a
Documents or Pictures folder.

Sorting and Grouping
Files

Sort Files and Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder that contains the
files you want to group.

Click or tap the Sort by button on
the View tab.

Select a sort by option on the
menu. 

◆ Options. Select an option, such
as name, Date, Size, Type, Date
modified, and Dimensions.

The available options vary
depending on the selected
folder type.

◆ Ascending. Select to sort items
in ascending order A-Z.

◆ Descending. Select to sort
items in descending order Z-A.

◆ Choose columns. Select to
customize the columns shown
in Details view. 

4
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See Also
See “Changing File and Folder List
Views” on page 80 for more informa-
tion on setting options for customizing
the columns shown in Details view.
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Group Files and Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder that contains the
files you want to group.

Click or tap the Group by button on
the View tab.

Select a group by option on the
menu. 

◆ Options. Select an option, such
as name, Date, Size, Type, Date
modified, and Dimensions.

The available options vary
depending on the selected
folder type.

◆ (None). Select to remove the
group by option.

◆ Ascending. Select to group
items in ascending order A-Z.

◆ Descending. Select to group
items in descending order Z-A.

◆ Choose columns. Select to
customize the columns shown
in Details view. 

Click the Collapse or Expand
arrow next to the heading to
collapse or expand the grouping. 
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Did You Know?
You can size all columns to fit their
contents in Details view. In File
Explorer, open the folder you want to
size columns, click or tap Details on
the View tab, and then click or tap the
Size All Columns To Fit button on the
View tab. 
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Sometimes remembering precisely where you stored a file can be 
difficult. File Explorer allows you to use Windows Search Explorer (by
default) to help you find and view all of your files or folders in one
place. You start a search by using the Search box. As you type in a
Search box, the search looks for matches in the file name, contents,
and property tags, and displays the highlighted results in a Search
Results folder. If you don’t find the file or folders you’re looking for, you
can perform an advanced search using a menu from the Search box.
An advanced search gives you the option to find files or folders by type,
name, title, location, date (taken, modified, or created), size, or property
tag. The search locates files and programs stored anywhere in indexed
locations, which includes personal folders, e-mail, offline files, and web
sites in your History list.

Searching for Files 
and Folders

Create a Simple Search

In the desktop, click or tap the File
Explorer button on the taskbar.

Open an Explorer window in the
location where you want to
search.

Click or tap in the Search box.

A search tab appears. Disregard
the tab for a simple search.

Type a word or part of a word.

As you type, programs and files
that match your text appear
highlighted in the Search Results
window. You don’t have to press
Enter.

TROUBLE? In the Search box,
you must press Enter to start a
search for non-indexed files.

To clear and close the search,
click or tap the Close button (x) on
the Search tab or in the Search
box.
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Search
results

Highlighted search results
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Create an Advanced Search

In the desktop, click or tap the File
Explorer button on the taskbar.

Open an Explorer window in the
location where you want to
search.

Click or tap in the Search box.

A Search tab appears with
advanced options.

Click or tap the This PC, Current
folder, or All subfolders to specify
a search location.

Click or tap the Refine buttons you
want on the Search tab, and then
select an option.

◆ Date modified. Searches by
date modified.

◆ Kind. Searches by kind of file,
such as Document, E-mail,
Video, or Instant Message.

◆ Size. Searches by file size.

◆ Other properties. Searches by
file type, name, folder path, or
property tag.

To set additional options, click or
tap the Advanced options button,
and then click or tap Partial
matches, File contents, System
files, or Zipped (compressed
folders) to enable or disable.

Type in search criteria in the
Search box or select from the
available criteria.

To search again in other locations,
click or tap the Search again in
button, and then click or tap
Homegroup, Libraries, or Internet.

To clear and close the search,
click or tap the Close button (x) on
the Search tab or in the Search
box.
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If you frequently perform the same search, you can save your search
results like any file and perform or modify the search again later. When
you save a search, the search is saved by default with Window Search
Explorer in the Searches folder in your personal folder and added to the
Favorites folder in the Navigation pane. Like any link, you can move a
saved search from the Searches folder to the Favorites category in the
Navigation pane to make it more accessible. To run a saved search,
display the saved search link, and then click or tap it.

Saving a Search

Save a Search

In the desktop, click or tap the File
Explorer button on the taskbar.

Open an Explorer window in the
location where you want to
search.

Click or tap in the Search box,
specify the criteria you want, and
then perform the search.

Click or tap the Save search
button on the Search tab.

Type a name for the search.

Click or tap Save.

To use a saved search, click or tap
the saved search link in Favorites
in the Navigation pane or double-
click or double-tap the saved
search in the Searches folder in
the personal folder.
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Did You Know?
You can quickly perform a recent
search. Click in the Search box to the
display the Search tab. Click or tap the
Recent Searches button, and then
select a recent search. If the list gets
cluttered, you can clear items. Click or
tap the Recent Searches button, and
then click or tap Clear Search History.

2
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Changing Search
Options

Change Search Options

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the Options button on
the View tab, and then click or tap
Folder and search options.

Click or tap the Search tab.

Select or clear the check boxes
under How to search:

◆◆ Don’t use the index when
searching in file folders for
system files (searches might
take longer).

Select or clear the check boxes
under When searching non-
indexed locations:

◆◆ Include system directories.

◆◆ Include compressed files (ZIP,
CAB, ...)

◆◆ Always search file names and
contents (this might take
several minutes)

Click or tap OK.6
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When you perform a search for files or folders, File Explorer uses the
search options to help customize the search results. You can specify
whether you want to search for file names and content or just for file
names and whether to include subfolders. For non-indexed searches,
you can set options to include system directories or compressed files
(ZIP, CAB...), or always search file names and contents. The search
options are available in the Folder Options dialog box under the Search
tab.

6

3

5

4



70 Chapter 3

Windows keeps track of files in indexed locations and stores informa-
tion about them in the background using an index, like the one found in
the back of this book, to make locating files faster and easier. You can
use Indexing Options in the Control Panel to view, pause, add, remove,
and modify indexed locations, indexed file types, and other advanced
index settings. For example, if a file type is not recognized by the index,
you can add it; if you want to stop indexing new content for 15 minutes
to specify options, you can pause it; or if you’re having problems with
the search index, you can rebuild or restore it.

Modifying the Index 
to Improve Searches

View, Pause, Add, or Remove
Indexed Locations

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap This PC in the
Navigation pane, and then click or
tap the Open Control Panel button
on the Computer tab.

◆ In the Start screen, you can
also click or tap Apps view
button, and then click or tap
Control Panel.

Click or tap the Indexing Options
icon in Small icons or Large icons
view.

To pause new indexing for 15
minutes, click or tap Pause.

Click or tap Modify.

If you don’t see all the locations,
click or tap Show all locations.

If a folder location contains
subfolders, click or tap the Expand
arrow to expand it.

Select or clear the check box next
to the folder locations you want to
add or remove from the index.

Click or tap OK.

Click or tap Close.10
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Set Advanced Indexing Options

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap This PC in the
Navigation pane, and then click or
tap the Open Control Panel button
on the Computer tab.

Click or tap the Indexing Options
icon in Small icons or Large icons
view.

Click or tap Advanced.

Click or tap the Index Settings tab.

Select or clear the following check
boxes:

◆ Index encrypted files.

◆ Treat similar words with
diacritics as different words.

For index troubleshooting, use
either of these buttons:

◆ To re-index selected locations,
click or tap Rebuild.

◆ To restore your index to its
original settings, click or tap
Restore Defaults.

If you need to change the Index
Location, specify a new location or
click or tap Select new.

Click or tap the File Types tab.

Select or clear the check boxes
with the file types you want to
include or exclude in the index.

For each selected file type, click or
tap the option to specify how the
file should be indexed.

Click or tap OK.

Click or tap Close.13
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When you create a file, Windows automatically adds properties to the
files, such as name, creation date, modified date, and size. These prop-
erties are important to Windows, however, they may not be useful
when you are searching for a file. You can add or modify common file
properties and create or modify custom tag properties to make it faster
and easier to locate files in the future. You can add or modify properties
for most files. However, there are some exceptions, such as plain text
(.txt) or rich text format (.rtf) files. You can add or modify properties
using the Details pane in an Explorer window, the Details tab in the
Properties dialog box, or in some Save As dialog boxes. If you want to
remove some or all of the property information in a file, you can quickly
remove it using the Properties dialog box.

Adding Properties 
and Tags to Files

Add or Modify Properties

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the file you want to
add or modify properties.

In the Details pane, click or tap the
tag you want to change, and then
type the new tag.

◆ To display the Details pane,
click or tap the Details pane on
the View tab.

◆ If you want to work with more
properties and tags, right-click
or tap-hold the file, click or tap
Properties, and then click or
tap the Details tab. When
you’re done, click or tap  Apply.

To add more than one tag,
separate each entry with a
semicolon. 

To rate a file using the rating
property, click or tap the star that
represents the rating you want to
give the file.

Click or tap Save.6
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Remove Properties

In the desktop, click or tap the File
Explorer button on the taskbar,
and then locate the file in which
you want to change.

Select the file you want to remove
properties.

Click or tap the Properties button
on the Home tab, and then click or
tap Remove properties.

Click or tap the Create a copy with
all possible properties removed
option or click or tap the Remove
the following properties from this
file: option.

Select or clear the check boxes
for each property.

Click or tap OK.6
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Did You Know?
You can add properties while you save
a file. In some Save As dialog boxes,
such as Microsoft Word, you can
specify properties, such as Author and
Tags. 
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The keys to organizing files and folders effectively within a hierarchy
are to store related items together and to name folders informatively.
Creating a new folder can help you organize and keep track of files and
other folders. In order to create a folder, you select the location where
you want the new folder, create the folder, and then lastly, name the
folder. You should name each folder meaningfully so that just by read-
ing the folder’s name you know its contents. After you name a folder or
file, you can rename it at any time.
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Creating and
Renaming Files 
and Folders

Create a Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the drive or folder where you
want to create a folder.

Click or tap the New Folder button
on the Home tab.

TIMESAVER Right-click or tap-
hold a blank area of the window,
point to New, and then click or tap
New folder.

With the New Folder name
selected, type a new name.

Press Enter or tap in a blank area.5
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Did You Know?
File names can be up to 255 
characters. You can use spaces and
underscores in names, but you can’t
use the following characters: @ * : < >
| ? “ \ or /. Remember the best way to
keep your files organized is with a 
consistent naming convention.  
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Rename a File or Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the file or folder you want
to rename.

Click or tap the Rename button on
the Home tab.

With the name selected, type a
new name, or click or tap to
position the insertion point, and
then edit the name.

Press Enter or tap in a blank area.

TIMESAVER Right-click or tap-
hold the file or folder you want to
rename, click or tap Rename, type
a name, and then press Enter or
tap in a bland area. You can also
select the file, click or tap the file
name, type a name, and then press
Enter or tap in a blank area.
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Did You Know?
You can rename a group of files.  In
File Explorer, select all the files you
want to rename, right-click or tap-hold
one of the selected files, click or tap
Rename from the shortcut menu, type a
name, and then press Enter or tap in a
blank area. The group name appears
with numbers in consecutive order.
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Sometimes you will need to move a file from one folder to another, or
copy a file from one folder to another, leaving the file in the first location
and placing a copy of it in the second. You can move or copy a file or
folder using a variety of methods. If the file or folder and the location
where you want to move it are visible in a window or on the desktop,
you can simply drag the item from one location to the other. Moving a
file or folder on the same disk relocates it whereas dragging it from one
disk to another copies it so that it appears in both locations. When the
destination folder or drive is not visible, you can use the Move to or
Copy to commands or the Cut (to move), Copy, and Paste commands on
the Home tab to move or copy the items. 
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Copying and Moving
Files and Folders

Copy or Move a File or Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the drive or folder containing
the file or folder you want to copy.

Select the files or folders you want
to copy or move.

Click or tap the Copy or Cut (to
move) button on the Home tab.

Display the destination folder
where you want to copy or move
the files or folder.

Click or tap the Paste button on
the Home tab.
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6 Pasted folder
Did You Know?

You can copy or move directly to a
folder or drive. In File Explorer, select
the files or folder you want to copy or
move, click or tap the Copy to or Move
to button on the Home tab, and then
select a destination or click or tap
Choose location to select the one you
want. 
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Copy or Move a File or Folder
Using Drag and Drop

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the drive or folder containing
the file or folder you want to copy
or move.

Select the files or folders you want
to copy or move.

In the Navigation pane, point to a
folder list to display the expand
and collapse arrows.

Click or tap the arrows to display
the destination folder.

Right-click or tap-hold the
selected files or folders, drag to
the destination folder, and then
click or tap Copy Here or Move
Here.

TIMESAVER To move the
selected items, drag them to the
destination folder. To copy the
items, hold down the Ctrl key 
while you drag.
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Sending Files and Folders
When you right-click or tap-hold most objects on the desktop or in
This PC or File Explorer, the Send To command, located on the short-
cut menu, lets you send, or move, a file or folder to a new location
on your PC computer. For example, you can send a file or folder to a
removable disk to make a quick backup copy of the file or folder, to a
mail recipient as an electronic message, or to the desktop to create
a shortcut. You can also use the Send To command to move a file or
folder from one folder to another. To send a file or folder, right-click
or tap-hold the file or folder you want to send, point to Send To on
the shortcut menu, and then click or tap the destination you want. 

For Your Information

5

3

Did You Know?
You can transfer files using a disk. You
can copy files from your PC computer
to a disk if you need to either transfer
files from one stand-alone PC com-
puter to another. You can also save a
copy of important files to prevent los-
ing them in the event of a power failure
or a problem. You can use several
methods: copy and paste, drag and
drop, and the Send To command.



When you organize the contents of a folder, disk, or the desktop, you
might find files and folders that you no longer need. You can delete
these items or remove them permanently. If you delete a file or folder
from the desktop or from the hard disk, it goes into the Recycle Bin. The
Recycle Bin, located on your desktop, is a temporary storage area for
deleted files. The Recycle Bin stores all the items you delete from your
hard disk so that if you accidentally delete an item, you can remove it
from the Recycle Bin to restore it. Be aware that if you delete a file
from a removable disk or use the Permanently delete command, it is
permanently deleted, not stored in the Recycle Bin. The files in the
Recycle Bin do occupy room on your PC computer, so you need to
empty it to free up space.
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Deleting and
Restoring Files 
and Folders

Delete Files and Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the files and folders you
want to delete.

Click or tap the Delete button
arrow on the Home tab, and then
click Recycle or Permanently
delete.

TIMESAVER Press the Delete
key to recycle the items or press
Shift+Delete to permanently delete
the items. 

If prompted, click or tap Yes to
confirm the deletion and place the
items in the Recycle Bin.

◆ Enable delete confirmation.
Click or tap the Delete button
arrow on the Home tab, and
then click or tap Show recycle
confirmation.

In the desktop, right-click or tap-
hold the Recycle Bin icon, and
then click or tap Empty Recycle
Bin.

Your device permanently removes
the items.
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Restore Files and Folders

In the desktop, double-click or
double-tap the Recycle Bin icon
on the desktop. 

Select the item or items you want
to restore.

Click or tap the Restore this item
or Restore all items button on the
Manage tab.

◆ Empty Recycle Bin. Click or tap
the Empty Recycle Bin button
on the Manage tab, and then
click or tap Yes to confirm.

If prompted, click or tap Yes to
confirm the restore or click or tap
No to cancel it.
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Did You Know?
You can undo a deletion. If you acci-
dentally delete a file, click or tap the
Undo button on the Quick Access tool-
bar. Windows remembers your last
three actions.

You can’t open a deleted folder and
restore selected items. When you’ve
deleted a folder, you have to restore
the entire folder. 

Changing Recycle Bin Properties
You can adjust several Recycle Bin settings by using the Properties
option on the Recycle Bin shortcut menu or the Recycle Bin proper-
ties button on the Manage tab in the Recycle Bin window. For exam-
ple, if you want to delete files immediately rather than place them in
the Recycle Bin, right-click or tap-hold the Recycle Bin, click or tap
Properties, and then select the Don’t Move Files To The Recycle Bin
check box. Also, if you find that the Recycle Bin is full and cannot
accept any more files, you can increase the amount of disk space
allotted to the Recycle Bin by increasing the Maximum size (MB)
amount.

For Your Information
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You can display files and folders in a variety of different ways, depend-
ing on what you want to see and do. When you view files and folders in
Details view, a default list of file and folder information appears, which
consists of Name, Size, Type, and Date Modified. If the default list of file
and folder details doesn’t provide you with the information you need,
you can add and remove any file and folder information from the Details
view. If you need to change the way Windows sorts your files and fold-
ers, you can use the column indicator buttons in the right pane of
Details view. Clicking or tapping one of the column indicator buttons,
such as Name, Size, Type, or Date Modified, in Details view sorts the
files and folders by the type of information listed in the column.  

Changing File and
Folder List Views

Change File Details to List

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder you want to
change in Details view.

Click or tap the Add column button
on the View tab, and then click or
tap a column (select or clear
check mark) or click or tap Choose
columns.

Select the check boxes with the
details you want to include and
clear the ones you don’t.

Click or tap the Move Up or Move
Down buttons to change the order
of the selected items.

Click or tap the Show or Hide
buttons to show or hide the
selected items.

Specify the width in pixels of the
column for the selected items.

Click or tap OK.8
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Did You Know?
An ellipsis indicates information is
hidden. To show the information, drag
the edge of the column indicator 
button to resize the column. 
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If you want to hide files and folders for added privacy purposes, you
can do it by setting two separate options: one to set the option to hide
specific files and folders, and the other to set a general folder option to
show or hide files and folders. If you set the option to hide specific files
and folders and the Show hidden files and folders option is set, the hid-
den files and folders appear transparent. If the general option is set to
Do not show hidden files and folders, the hidden files and folders are
actually hidden. The only way to view them again is to set the general
option to Show hidden files and folders again. Anyone can show hidden
files and folders, so it shouldn’t be used for security purposes.

Hiding Files and 
Folders

Show or Hide Hidden Files and
Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the files or folders you want
to hide or unhide.

Click or tap the Hide selected
items button on the View tab.

Select the Hidden items check box
on the View tab to show hidden
files or folders. To hide hidden
items, clear the check box.

The hidden files or folders appear
transparent.

To unhide hidden files or folders,
select them, and then click or tap
the Hide selected items button on
the View tab.
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Did You Know?
You can set options to show or hide
files and folders. In File Explorer, click
or tap the Options button on the View
tab, click or tap Change folder and
search options, click or tap the Do Not
Show Hidden Files And Folders or
Show Hidden Files And Folders option,
click or tap Apply to Folders, and then
click or tap OK.
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When you work with files and folders, Windows displays folder con-
tents in a standard way, known as the default. The default folder view
settings are as follows: Tiles view displays files and folders as icons;
common task links appear in the left pane; folders open in the same
window; and items open when you double-click or double-tap them.
Depending on previous installation or users, your folder view settings
might differ. Instead of changing the folder view to your preferred
view—Icons, List, or Details—each time you open a folder, you can
change the view permanently to the one you prefer. In addition to the
defaults, you can change options such as folder settings to show or
hide file extensions for known file types, show or hide hidden files and
folders, show or hide protected operating system files, and show pop-
up descriptions of folders and desktop items. You can also set
Navigation pane options to show all folders like the Folder list and auto-
matically expand the folder list to the current folder. 
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Changing Folder
Options

Change Folder Options

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the Options button on
the View tab, and then click or tap
Change folder and search options. 

Click or tap the General tab. 

Select a Browse folders option to
display each folder in the same
window or its own window.

Select a Click items as follows
option to single-click or double-
click items. 

Select the Navigation pane check
boxes option to  Show all folders
or Automatically expand to
current folder.

Click or tap OK.7
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Did You Know?
You can restore all folder options to
default Windows settings. On the
General tab in the Folder Options dia-
log box, click or tap Restore Defaults. 
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Change the Folder View

In the desktop, click or tap the File
Explorer button on the taskbar.

Click or tap the Options button on
the View, and then click Change
folder and search options. 

Click or tap the View tab.

To set the current view to all
folders, click or tap Apply to
Folders.

Select the check boxes for the
options you want, and clear the
check boxes for the ones you
don’t. Some common options
include:

◆ Always show menus.

◆ Hidden files and folders.

◆ Hide extensions for known file
types. 

◆ Hide protected operating
system files (Recommended).

◆ Show encrypted or
compressed NTFS files in
color.

◆ Show pop-up description for
folder and desktop items.

Click or tap OK.6
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Did You Know?
You can reset folder views to original
Windows settings. On the View tab in
the Folder Options dialog box, click or
tap Reset Folders. 

Understanding File Extensions
The program Windows uses to open a document depends on a three-
letter extension to the document’s file name, called a file extension.
You might have never seen a document’s file extension because your
system might be set up to hide it. The file extension for simple text
files is “.txt” (pronounced “dot t-x-t”), and many graphic files have
the extension “.bmp”. This means that the full name for a text file
named Memo is Memo.txt. If you double-click or double-tap a docu-
ment whose file name ends with the three-letter extension “.txt,”
Windows automatically opens the document with Notepad, a text-
only editor. If you want to display file extensions in dialog boxes and
windows, select or clear the File Name Extensions check box on the
View tab in File Explorer. If you want to change the program Windows
automatically starts with a given file extension, open the Control
Panel (click or tap This PC in File Explorer, and then click or tap the
Open Control Panel button on the Computer tab), click or tap Default
Programs in Small or Large icons view, click or tap Default Programs,
click or tap Associate A File Type Or Protocol With A Program, select
the file type, and then click or tap Change Program to see the list of
the file extensions Windows recognizes and the programs associated
with each of them, and then make changes as appropriate.

For Your Information
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In your library folders, you can customize view options based on the
contents. In the tab of the Pictures and Music library folders, Windows
provides buttons with file management activities specifically related to
the contents of the folder, such as Slide Show in the Pictures library, or
Play All in the Music library. The Arrange by options are also related to
the folder contents, such as Rating in the Pictures library, or Artist in
the Music library. When you create a new library folder, you can cus-
tomize it for documents, pictures, music, and videos by applying a
folder template, which is a collection of folder tasks and viewing
options. When you apply a template to a folder, you apply specific fea-
tures to the folder, such as specialized tasks and viewing options for
working with documents, pictures, music, and videos.  

Customizing Library
Folders

Customize a Library Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the library folder you want to
change.

Click or tap the Properties button
on the Home tab.

Click or tap the Optimize this
library for list arrow, and then
select the type of folder you want:
General Items, Documents, Music
Pictures, or Videos.

TIMESAVER Click or tap the
Optimize library for button on the
Manage tab, and then select an
option.

To show or hide the library in the
Navigation pane, select or clear
the Shown in navigation pane
check box.

To restore library default settings
for this folder, click or tap Restore
Defaults.

Click or tap OK.7
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In your personal folders, you can create your own folders and cus-
tomize view options based on the contents. In the toolbar of the
Pictures and Music folders, Windows provides buttons with file 
management activities specifically related to the contents of the folder,
such as Slide Show in the Pictures folder, or Play All in the Music
folders. When you create a new folder, you can customize it for 
documents, pictures, music, and videos by applying a folder template,
which is a collection of folder tasks and viewing options. When you
apply a template to a folder, you apply specific features to the folder,
such as specialized tasks and viewing options for working with docu-
ments, pictures, music, and videos.  

Customizing Personal
Folders

Customize a Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the folder you want to
change.

Click or tap the Properties button
on the Home tab.

Click or tap the Customize tab for a
folder.

Click or tap the Optimize this
folder for list arrow, and then
select the type of folder you want:
General Items, Documents,
Pictures, Videos, or Music.

Select the Also apply this
template to all subfolders check
box to apply the option.

To select a picture for display on
the folder icon, click or tap Choose
File.

To restore the default picture for
the folder, click or tap Restore
Default.

Click or tap OK.9
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File Explorer maintains a set of personal folders and options for every-
one on your PC computer to make sure the contents of each user’s per-
sonal folders remain private. The contents of your personal folders are
private, unless you decide to share the contents with others who use
your PC computer or SkyDrive. If you want the other users to have
access to shared files, you can place those files in a shared folder on
your SkyDrive (New!) called the Public folder that users can access
online. If you’re connected online, the files in the public folder are avail-
able to users. You can also share files from any folder on your PC com-
puter that you want to designate as a shared folder to those connected
to your network or Homegroup, a shared network. When you specify a
shared folder, you can also set access permission levels for a person or
group. If you no longer want to share a folder, you can stop sharing.

Sharing Folders or
Files with Others

Share a File or Folders from the
Public Folder on SkyDrive

In the desktop, click or tap the File
Explorer button on the taskbar.

Open the drive or folder containing
the files or folders you want to
share.

Select the files or folders you want
to share. 

In the Navigation pane, point to a
folder list to display the expand
and collapse arrows.

Click or tap the arrow next to the
SkyDrive (New!) to display the
Public folder, and then click or tap
the arrow next to the Public folder
(if available) to display the Public
subfolders.

Drag the selected items onto the
Public folder or subfolder where
you want to share files.

6

5

4

3

2

1

5

4 3

See Also
See “Setting Network Sharing Options”
on page 403 for information on control-
ling access to a public folder over a
network

6
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Share or Unshare a Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the folders you want to
share or unshare. 

Click or tap Specific people on the
Share tab to set multiple options.

◆ Share with options. Click or 
tap Homegroup (view) or
Homegroup (view and edit) or a
contact.

◆ Unshare a folder. Click or tap
the Stop sharing button.

Do any of the following:

◆ Type the name of the person
with whom you want to share
files, and then click or tap Add.

◆ Click or tap the arrow to the
right of the text box, click or tap
the person’s name, and then
click or tap Add.

Click or tap the arrow next to the
permission level for the person or
group, and then select a sharing
permission:

◆ Read. Allows viewing only.

◆ Read/Write. Allows viewing,
adding, changing, and deleting
all files.

◆ Remove. Deletes the current
permission setting.

Click or tap Share, and then wait
while Windows sets up sharing.

If you want, click or tap the e-mail
or copy link to notify people you
have shared this folder and files.

Otherwise, click or tap Done.8
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Use to stop sharing
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You can compress files in special folders that use compressing soft-
ware to decrease the size of the files they contain. Compressed folders
are useful for reducing the file size of one or more large files, thus free-
ing disk space and reducing the time it takes to transfer files to another
PC computer over the Internet or network. A compressed folder is
denoted by a zippered folder icon. You can compress one or more files
in a compressed folder by simply dragging them onto the compressed
folder icon. When a file is compressed, a copy is used in the compres-
sion, and the original remains intact. You can uncompress, or extract, a
file from the compressed folder and open it as you normally would, or
you can open a file directly from the compressed folder by double-
clicking or double-tapping it. When you open a file directly, Windows
extracts the file when it opens and compresses it again when it closes.

88 Chapter 3

Compressing Files
and Folders

Compress Files and Folders

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the files and folders you
want to copy to a compressed
folder.

Click or tap the Zip button on the
Share tab. 

◆ Right-click or tap-hold one of
the selected items, point to
Send to, and then click or tap
Compressed (zipped) folder.  

If you want, rename the
compressed folder, and then press
Enter or tap a blank area.

To copy additional files or folders
to the compressed folder, drag the
files onto the compressed folder.

5

4

3

2

1
23

5

Compressed
folder
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View Compressed Files

In the desktop, click or tap the File
Explorer button on the taskbar.

Double-click or double-tap the
compressed folder to open it.

Double-click or double-tap an item
in the folder to open it using its
associated program. 

Uncompress Files and Folders

◆ Individual files or folders. In File
Explorer, double-click or double-
tap the compressed folder to open
it, select the files and folders you
want to uncompress, and then
drag the selection from the
compressed folder to a new
location in an uncompressed
folder.

◆ All files. In File Explorer, double-
click or double-tap the
compressed folder, and then click
or tap the Extract all button on the
Extract tab, and then step through
the Extraction Wizard.

3

2

1

Did You Know?
You can also compress file attributes
in a folder. Select the folder, click or
tap the Properties button on the Home
tab, click or tap Properties, click or tap
the General tab, click or tap Advanced,
select the Compress Contents To Save
Disk Space check box, and then click
or tap OK twice.

Extract all button

2

Opened compressed folder



The low cost and large storage size of discs, either CD or DVD, makes
creating and using CDs or DVDs an effective way to back up informa-
tion or transfer large amounts of information to another PC computer
without a network. Before you can create a CD or DVD, you must have
a blank writable disc and a recorder (also known as a writer or burner)
installed on your PC computer. You can copy, or write, files and folders
to either a writable disc (CD-R or DVD-R) or a rewriteable disc (CD-RW
or DVD-RW). With writable discs, you can read and write files and fold-
ers many times, but you can’t erase them. With rewriteable discs, you
can read, write, and erase files and folders many times, just like a hard
disk. When you burn a disc, Windows needs disk space on your hard
disk equal to the capacity of the disc. For a typical CD, this is between
650 and 740 megabytes (MB) and for a DVD, this is about 4.7 gigabytes
(GB). Do not copy more files and folders to the CD or DVD than it will
hold; anything beyond the limit will not copy. You can burn a disc using
one of two formats: Live File System or Mastered. The Live File System
format (Like a USB flash drive option) allows you to copy files to a disc
at any time, while the Mastered format (With a CD/DVD player option)
needs to copy them all at once. If you need a disc and want the con-
venience of copying files at any time, the Live File System is the best
choice. When you need a compatible disc for older PC computers, the
Mastered format is the better choice.
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Managing Files 
Using a CD or DVD

Burn a Disc Using the Mastered
Format

Insert a writable CD or DVD into
your CD or DVD recorder.

Click or tap Burn files to disc in
the notification or click or tap the
Burn to disc button on the Share
tab in File Explorer.

Type a name for the disc.

Click or tap the With a CD/DVD
player option.

Click or tap Next to continue.

Open the folder that contains the
files you want to burn, and then
drag the files onto the empty disc
folder.

Click or tap Finish burning button
on the Manage tab, and then
follow the wizard steps.

The disc recorder tray opens when
the disc is complete.

7
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Burn a Disc Using the Live
System Format

Insert a writable CD or DVD into
your CD or DVD recorder.

Click or tap Burn files to disc or
click or tap the Burn to disc button
on the Share tab in File Explorer.

Type a name for the disc.

Click or tap the Like a USB flash
drive option.

Click or tap Next to continue.

Windows names, formats, and
prepares the disc for use.

Upon completion, open the folder
with the files you want to burn.

Drag the files into the disc folder.

As you drag files, they are copied
automatically to the disc.

To close the session and prepare
the disc for use, display the disc
folder, click or tap the Eject button
on the Manage tab.

After you close a session, you can
still add files to the disc. However,
you need to close the session.
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Did You Know?
You can erase some or all of the files
on a disc. Insert the writable disc with
the Live File System format, click or tap
This PC in File Explorer, click or tap the
writable drive, and then click or tap
Erase This Disc on the Manage tab to
erase all the files. Double-click or dou-
ble-tap the writable drive, select the
files you want to delete, and then click
or tap the Delete button on the Home
tab.

8

7
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It could take you a while to access a file or folder buried several levels
down in a file hierarchy. To save some time, you can create shortcuts
to the items you use frequently. A shortcut is a link that you can place
in any location to gain instant access to a particular file, folder, or pro-
gram on your hard disk or on a network just by double-clicking or dou-
ble-tapping. The actual file, folder, or program remains stored in its
original location, and you place an icon representing the shortcut in a
convenient location, such as in a folder or on the desktop.

Creating a Shortcut 
to a File or Folder

Create a Shortcut to a File 
or Folder

In the desktop, click or tap the File
Explorer button on the taskbar.

Select the file or folder in which
you want to create a shortcut.

Click or tap the New item button
on the Home tab, and then click or
tap Shortcut.

To change the shortcut’s name,
select it, click or tap the Rename
button on the Home tab, type a
new name, and then press Enter or
tap in a blank area.

Drag the shortcut to the desired
location.

5

4

3

2

1

2

Did You Know?
You can pin a folder or file to the Start
screen. In File Explorer, select the
folder or file you want to pin, click or
tap the Easy access button on the
Home tab, and then click or tap Pin to
Start.

Placing Shortcuts on the Desktop or Taskbar
You can place shortcuts to frequently used files, folders, and pro-
grams on the desktop or toolbar on the taskbar. To do this, simply
drag the shortcut file, folder, or program to the desktop. You can also
drag a shortcut to a toolbar on the taskbar using the same method.
When you release the mouse or finger, the item appears on the
desktop or toolbar.

For Your Information

3
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Index

A
Accelerator, 108
accelerators, using and managing, 114
Access apps and features, 40
Access Favorites, 117
access point (AP), 392
access privileges and permissions, 508
accessibility programs, using, 328
accessories, 23

working with, 267, 268
accounts

add to domain network, 341
child, 336, 340, 356-357
create new, 340
deleting, 342, 343
picture, change, 347
setting up, 335
view information, 37

Action Center, 336
change security settings, 352

actions, record a series of, 291
Activate Windows, 3, 512-513
Active Search Directory to find network

resources, 378
Ad-aware from Lavasoft, 361
Add a device, 209, 476
Add a printer, 417, 420
Add column button, 80
Add Network Location, 400
Add to Favorites button, 116
Add to Playlist button, 233, 264
add/remove. SSeeee  aallssoo delete

apps and accessories, 40
contact, 144
device, 475
language, 316
link, 62

media files to Library, 223
secondary monitor, 486-487
text to a picture, 201
user accounts, 340
Windows components, 455

Add-on Manager, 373
address bar, 48, 59, 96
address, on taskbar, 13
Administrative Tools, 493-495
administrator

account, 336
privileges, 456

Adobe Reader, 253, 431
advanced

indexing options, 71
options, change, 317
search, 66-67
settings, 317
startup, 303, 517

Advanced Options button, 67
Advanced Settings link, 312
Advanced System settings, 454
adware, 361, 373
Airbrush tool, 202
airplane mode, turn on or off, 395
alarms, 259
All Apps button, 24, 25, 52, 268
allocation unit, 444
alphabetically sorting tiles icons, 49
antivirus software, 130-131, 171, 360
application or app, 1, 23. SSeeee  aallssoo apps,

programs
Applications and Services Log, 497
Apply Skin (WMP), 229
apps, 1, 23

access, 40
adjusting size on screen, 33
Alarms, 259
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aappppss  ((ccoonnttiinnuueedd))
closing from tile, 8, 29
closing full screen view of, 8, 29
customize, 40
display, 24-25, 33
Finance, 28
Food & Drink, 248
from store, viewing, 37
Games, 263
grouping on Start screen, 42
Health & Fitness, 249
how to close, 29
installing from store, 36, 37
Internet Explorer, 94, 100
Mail, 157
Maps, 46, 250-251
Music, 264-265
New releases, 36
notifications, enable or disable, 44
open, switch between, 32
People, 135
Photos, 191
privacy options for, 46, 266
recently used, 32
reinstall from store, 37
RemoteApp, 413
remove from split screen, 33
Scan, 209, 442
search for, 23, 26, 36
set notification options, 44
search options for, 45
settings, how to change, 31

synchronize, 301
shared most often, 35
sharing between, 34
shorten list of, 45
side by side, 33
SkyDrive, 191, 192, 254-258
Skype, 46, 177-190
Sound Recorder, 234-235
Sports, 244-245
starting, 29
switch between, 8, 32, 302
switch between Start screen and, 8
thumbnail, 8
tile option, 199
tiles, group on Start screen, 42

tiles, resize, 42
Top Free, 36
Travel, 243
uninstalling, 39
updates screen, 38
used most often, 35
using different, 28
view performance, 502
Video, 262
Weather, 246-247
Xbox SmartGlass, 262, 263

App bar, 4
displaying within metro app, 30
formatting email, 166
how to use, 30
minimized, 30
reinstalling apps from store, 37
saving draft of email, 165
uninstalling apps, 39

apps view button, 6-7, 24-25
Apps screen, 268

accessing, 24-25
customizing Start screen, 40
searching, 26-27
sorting apps on, 25

App tile size, changing, 42
Arrange By command, 56
arrange windows, 13

library files, 56
arrows, 17

using in Folders list, 60
ascending order sort, 64, 65
Asian language characters, 316
attachments, 170
attacks, avoiding harmful, 360
audio 

formats supported, 222
phone calls, making in Skype, 186-187

Audio Output, 330
Audio pop-up notification, 219
audit policies, 505 SSeeee  aallssoo security
authority certificate, 362
Auto Playlist, create, 224-225
Auto Sync, 229
AutoComplete, 106 

change options, 107
delete history, 107
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on IE app, 96
Auto-hide the taskbar, 322
Automatic Updates, 360
Automatically expand to current folder, 82
AutoPlay pop-up notification, 210
avoiding hacker attacks, 349

B
background SSeeee  aallssoo desktop

acceptable file formats, 213
add picture to list, 213
change desktop, 305
picture from web page, 127
printing, 428
set photo as, 199
set picture for desktop, 213

backing up
files, File History, 462-464
to CD or DVD, 90

bad sectors (disk errors), 450
battery life, extending, 488
Bing

changing options, 45
using, Internet Explorer, 100-101

bit image sizes, 214
BitLocker SSeeee  aallssoo encrypt

encrypting a disk, 451
encrypting files, 359

bitmapped (BMP), 214
background file, 213
file, 200
font, 319
picture format, 201

blink rate of insertion point, 479
block content

with InPrivate browsing, 370
with TPL, 372

block pop-up ads, 369
Bluetooth technology, 391
Blu-ray (High Density Blu-ray Disc), 53
boost speed with removable disk, 454
borders, using to resize window, 15
Break Link, 285
bridge, hardware device, 376
browser, open and close, 18

add-ons, managing, 373
browsing

move back or forward, 110
privately, 111
stop, refresh or go home, 110
the web, 106
with tabs, 108

Brush tool, 202
burn files to disc, 90-91
Burn to disc button, 90
buttons, accessing using Ribbon, 48
byte, 448

C
Calculator app or program, using, 286-287
Calendar app, 135 SSeeee  aallssoo events

change view, 149
changing options, 156
delete an event, 155
edit an event, 154, 155
schedule events with reminders, 153
scheduling events, 150-152
starting, 148

Called Subscriber Identifier (CSID), 441
Camera app, 239, 260-261
Camera options button, 260
cancel printing, 427
capture

image with Snipping Tool, 290
video, 261

Cascade windows, 13, 15
categories of folders, 60
CD, copy to, 90, 228
CD-R (Compact Disc-Recordable), 53
CD-ROM (Compact Disc-Read-Only

Memory), 53
CD-RW (Compact Disc-Rewritable), 53
CD-RW, erasing, 447
certificates (digital ID), 362, 368 SSeeee  aallssoo

security
Certification Authority (CA), 368
change 

account picture, 347
app settings, 31
app switching options, 32
calendar options, 156
calendar view, 149
date and time, 314, 315
default options, 324
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cchhaannggee  ((ccoonnttiinnuueedd))
desktop icons, 53, 308
dial-up connection, 389
display size, 312-313
Explorer layout, 61
fax properties, 441
file and folder details, 80
File Explorer window view, 49
folder options, 82
folder view, 83
General settings, 302
home page in IE, 105
how a disc or device starts, 326
IE app settings, 102
keyboard settings, 479
messaging options in Skype, 182-183
mouse settings, 480
my status, messaging in Skype, 180, 186
notifications, 44
password, 348
phone dialing options, 482
Photos app options, 192
pointer appearance & options, 481
printer preferences, 429
printer properties, 428
program, 325
regional options, 318
rip music settings, 227
search option, 45, 69
share settings, 35
Start screen, 346
system configuration options, 510
text size on screen, 311
Text-to-Speech options, 330. 
user account settings, 338, 339
user account type, 345
Windows Defender options, 355
Windows Update Driver settings, 478
zoom level, 113

Character map accessory, 281
character repeat rate, 479
Charms bar, 6-7, 9
Charms bar, searching for email, 175
check a disk for errors, 450
Check box, 17
Check Disk, 450
check for memory problems, 501

check mark replacing arrow, 63
Check This Website, security, 371
child account, 336, 340, 356-357
Choose columns, 80
Choose Program command, 55
Choosing commands on the Ribbon, 51
clean install, 513
clean up

disk, 453
Internet files and info, 366

Cleanup button, 453
Clear all operation, 45
Clear changes command, 56
ClearType, 311
clicking, 4-5
client type, network connection, 383
client/server networking, 376
Clipboard, using, 274
clocks, display additional, 314-315
Close button, 15
Close search, 66

web browser, 18
window using buttons, 15

cloud, connecting to, 3
collapse grouping, 65
color management, 484
column indicator buttons, 80
columns, size in Details view, 65
command buttons, 17, 50-51
command line (text-based interface), 267
Command Prompt, 288, 447, 468

window, change appearance of, 289
command syntax, 288
commands, 16

accessing, 16
common DOS, 289
disabling, 16
find a, 288
get info about, 289
running, 288

command-line interface, 288
common locations, 59
Compatibility Center for Windows 8.1, 515
compatibility view, using, 112
compatibility, set for older program, 295
compression

compressible file formats, 214
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compressing files and folders, 88
searching files, 69
viewing files, 89

computer 
control a remote, 412
icon, add to desktop, 53
lock and unlock, 351
maintenance, 443
properties, viewing network, 38
startup options, 470
window, 52

Computer Management tools, 506
Computer Name tab, 385
configure a network, 384

system restore, 467
connect

to a network over the Internet, 390
to a network, 388
to a wireless network, 392
to the Internet wizard, 133
to the Internet, 132

connection wizard, 388, 392
deleting, 389

conserve computer’s resources, 268, 280
SSeeee  aallssoo Power Plan

contact support, 19
contacts, 135 SSeeee  aallssoo People app

adding from online accounts, 138, 139
adding or editing, 144, 145
creating favorites, 143
currently online, viewing, 140
deleting, 146
editing, 145
linking, 147
pinning to Start screen, 143
sorting or filtering, 142
in Skype, 184-185, 190
viewing, 140, 141

Content view, 49
Contextual tab, 50
Control Panel

change location settings, 46
search for options, 304
use to adjust Windows features, 297

control remote computer, 412, 413
convert a disk, 447
cookies, 363, 366-367
Copy Here command, 77

Copy To command, 76
copying

fax cover page template, 435
file or folder, 76
music to CD, 228
music to portable device, 229
text, 275

corner navigation, 7, 307
Create and view an XPS document, 431
Create Basic Task wizard, 496
Create playlist button, 224, 225
Create Task dialog box, 496
creating 

dial-up connection, 388, 389
document, 272
fax cover page, 434
files and folders, 74
guest account, 344
homegroup, 404, 405
local user account, 386, 387
new library, 57
picture password, 348
restore point, 467
security zones, 364
shortcut to a file or folder, 92
shortcut to a network, 400, 401
sound file, 234-235
sound scheme, 236
sticky notes, 292
system image, 465
system recovery drive, 468
user accounts, 336
VPN connection, 390, 391

credentials agency, 362
Crop button, 261
crop photo, Photos app, 196
CSID (Called Subscriber Identifier), 441
cursor thickness, 334
Customize Navigation pane, 62
customizing

apps on Start screen, 40
columns, 64
desktop appearance, 309, 306
folders, 85
game player, 263
library folders, 84
notification area, 323
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ccuussttoommiizziinngg  ((ccoonnttiinnuueedd))
phone dialing options, 482
Windows, 297

Cut, Copy and Paste commands, 76

D
Date and Time dialog box, 314
Date modified, advanced search, 67
daylight savings, adjusting clock for, 314
decoder to play DVD movies, 219
default printer, 422
Default Programs icon, 324, 325
defaults 

folder view, 82
computer, 325
operating system, 469
reset all, 326
reset security options, 365

defend against malicious software, 354
defer printing, 426
defragment disk, 452
delete and insert text, 274
delete confirmation, enable, 78
deleting

contacts, 146
email, 174
history, 45
Internet files and info, 366
photos, 195
printer, 423
user account, 342, 343

descending order sort, 64, 65
desktop, 10

appearance, change, 306
background, change, 305
background, using a picture, 213
change volume from, 220
customize appearance, 309, 306
customize, 308
exploring, 10
icons, change, 53
preview using Peek, 308
remote connection, 413
showing, 12
start up, desktop/Start screen, 7, 307
taskbar, 12-13
themes, 306

windows, managing, 14
destination program, 282-285
Details pane button, 48-49, 52, 54, 61, 72, 82
Details view, 65
Detecting and repairing disk errors, 450
device

change the way it starts, 326
installing camera or scanner, 209 
memory, managing, 29
properties, 53

Device Manager, 477 
Devices and Printers

Add a device wizard, 476
changing preferences, 429
install fax modem, 433
set default printer, 422
set up non-detected printer, 421
viewing hardware, 474
viewing printers, 419

Devices button, 9, 266, 486-487
DHCP (Dynamic Host Configuration

Protocol) server, 513
dialog boxes, 17
dial-up connection

change, 389
create, 388, 389

digital camera, 210
add to Windows Media Center, 215
download pictures, 210
install, 209
manage pictures on, 211
use with Windows Media Center, 238
using with Photos app, 191, 192

digital ID, 362, 368
digital stereo receiver (WMP), 230
directions, Maps app, 250-251
disable 

call waiting check box, 482
offline files, 410
sharing libraries, 405
wireless network, 395

disc SSeeee  aallssoo CD; DVD
burn using Mastered format, 90
burn using Live System format, 91
erase files, 91

disconnect a wireless network, 398
Disk Cleanup, 453
Disk Defragmenter, 450, 452
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Disk Management, 507
disk

change the way it starts, 326
cleaning up, 453
converting, 447
encrypting, 451
error, detect and repair, 450
formatting, 446
info, display, 448
managing, 507
optimizing, 452
quotas, setting, 449
settings, view, 507
system recovery drive, 468

display adapter, 486-487
Display all apps, 24-25
Display folder contents, 55 SSeeee  aallssoo

Changing Explorer Window View, 49
display size, change, 312-313
display, dim, turn off, sleep, adjust 

brightness, 488
Display, Drives, 52
Display, tiles icons, 49
Display, change options, 40
displaying SSeeee  aallssoo customizing the

taskbar, 322
apps side by side, 33
basic system information, 448
buttons on taskbar, 320
captions and subtitles for DVD, 219
dates, times, currency and numbers, 318
default, 82
disk and folder info, 448
file-related menu commands, 51
files and folders, 80
files in ascending or descending 

order, 63
fixing view of older web sites, 112
frequently used buttons, 51
hidden buttons, 320
icons, 49
list of apps owned, 36
printer and communication ports, 420
printer status, 419
shared folders available on network, 378
slide show, 198
system information, 3
toolbars, 320

volume icon on taskbar
wireless connection and security 

properties, 397
Word Wrap, 277

documents SSeeee  aallssoo embedding; files; 
folders

create, 272
folder, 47, 54
open recent, 273
open from within a program, 273
printing, 424-425
saving and closing, 280
scan and fax, 437
scan, 442

Documents library folder, 54, 56
DOCX (Open Office XML document), 280
domain network, 378

change administrator password, 349
change user’s group, 345
create guest account, 344
joining, 386, 387
search, 379

domain, group of computers, 376
DOS commands, common, 289
double-clicking, double-tapping, 4
downloading

files from SkyDrive, 256
pictures from digital camera, 210
sound files, 222
video files, 222
Windows Live Essentials, 176

Drafts folder, email, 172
drag and drop, 275
dragging, 4-5
drawing, 200, 202
drive

letters, 52
letters, designate, 399
properties, 53

drivers
software, 472
removing to upgrade, 490

dual-boot, 469
DVD (Digital Video Disc), 53

commands, 237
copy to, 90
display captions & subtitles, 219
drive, 219
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DDVVDD  ((ccoonnttiinnuueedd))
play on Windows Media Player, 219
player, add to Windows Media Center,

215
player, extender device, 238

DVD-R (Digital Video Disc-Recordable), 53
DVD-ROM (Digital Video Disc-Read-Only

Memory), 53
DVD-RW (Digital Video Disc-Rewriteable), 53
DVD-RW, erasing, 447
Dynamic Host Configuration Protocol

(DHCP) server, 513

E
Ease of Access Center, 327-329

FilterKeys, 327
Get recommendations, 327-328
High Contrast, 327, 334
Magnifier, 327-329, 334
MouseKeys, 327
Narrator, 327-328, 330-331, 334
On-Screen Keyboard, 327-329, 334
questionnaire, 327
set options, 334
ShowSounds, 327
SoundSentry, 327
StickyKeys, 327
ToggleKeys, 327
using from Sign in screen, 328

Easy access button, 57, 399, 411
Easy Transfer Cable, 520-521
editing

contact, 145
object, 283
photos, 196-197
text, 274

EFS (Encrypting File System), 358
email (electronic mail)  SSeeee  aallssoo Mail app

getting started, 158
malicious attachments in, 361
picture, 208
viewing, 33

Email button, 208
embedding, 282-283

edit embedded data, 282
OLE (object linking and embedding), 285
one document in another, 282

resize embedded object, 282  
Emoticon button/menu, 188-189
emoticons, in messages, 188-189
Empty Recycle Bin button, 78, 79
encrypt 

disk with BitLocker, 451
file or folder, 358
files with BitLocker, 359

encryption
certificate, 358
password optimum length, 3

end task, 296
enhance display, WMP, 232
erase part of picture, 203
Erase This Disc button, 447
Eraser tool, 202, 203
Error Correction check box, 226
establish a dial-up connection, 389
Ethernet network, 394
Event Viewer, 497-499

managing event logs, 498-499
events SSeeee  aallssoo Calendar

associating a sound with, 236
editing and deleting, 154-155
scheduling with reminders, 153

Exchange accounts, with Mail app, 160
exFAT file system, 444, 446
exit Windows Accessory or system tool, 269
expand 

folder list, 62
grouping, 65

Explorer Window, changing, 48 SSeeee  aallssoo
File Explorer, Internet Explorer

Extra large icons, 204-205
Extract all button, 89

F
Facebook SSeeee  aallssoo People app

add contacts from account, 138
email with Mail app, 159, 162-163
manage with People app, 136-138
photos with Photos app, 192
view contacts currently online,140

Family Safety settings and web site, 356
FAT technology, 444-446
FAT32 technology, 444, 446
fault tolerance, 444
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Favorites Center/Favorites bar, 116
accessing and organizing, 117
copy to File History, 462-464
Navigation pane, 62

Fax Console, 438, 440
Fax Setups wizard, 432, 433
faxes, 432

answer mode, changing, 439
cancel or restart, 438
change properties, 441
cover page, 434
editor, 432, 434

list, 436-437
rename or delete, 435
template, 435

Inbox, 439
manage outgoing, 438
Outbox folder, 438
pause or resume outgoing, 438
printing, 417
receive manually, 439
remove from remote fax printer, 438
send and receive, 432
send from a document, 437
send, 436
sort by category, 440
Status column, 438
view sent, 436
view, print, save, email, 440

feeds (web feeds)
available feed formats, 121
button, 120-121
change feed settings, 121
subscribe to a feed, 120

File Explorer, 47 
button, 56
default list, 62
icon on taskbar, 12, 52, 204
Pictures library, 191, 192
using personal folders, 58
using the Explorer window, 48-49
viewing photos, 210

File History, 462-464
set up, 462-463
use to restore file, 464

File Name Extensions check box, 83
File tab on the Ribbon, 51

File Transfer Protocol (FTP) site, 400
files, 1. SSeeee  aallssoo attachments; compression;

documents; encrypt; folders;
links/linking; Media Center; offline
files; properties; Public folder; sharing

adding properties and tags, 72
attachments in email, 361
changing list views, 80
changing offline settings, 410
compressing, 88
contents, advanced search, 67
copying and moving, 76
creating shortcuts to, 92
deleting and restoring, 78
embed part of, 283
encrypting for safety, 358
encrypting with BitLocker, 359
extensions, understanding, 83
formats, understanding, 214
hiding, 81
hierarchy view, 60
keep in sync, 408
keep source and destination in sync, 284
library, 56
link part of, 284
make offline available, 411
manage using CD or DVD, 90
manage using network, 375
managing in network environment, 378
managing, 47, 74
protecting, 337
restoring, 79
save in new folder, 280
sending, 77
share with SkyDrive, 256
sharing with a homegroup, 407
sharing, 86
size, advanced search, 67
size, understanding, 448
sort by headings, 63
sync offline, 409
system, selecting, 445
system, understanding, 444
transferring from another computer, 

520-521
uncompressing, 89
upload to the SkyDrive, 257
view using icons view, 49
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fill 
command in Paint, 200
part of picture, 203
with color tool, 202-203

FilterKeys, 327
filtering 

contacts, 142
to organize files, 63

Finance app, 28
change language for, 242
using/updates, 242

find SSeeee  aallssoo search
apps and accessories, 40
command, 288
Drive or device properties, 53
information with IE app, 100
Windows system info, 53

finger gestures, 4, 5
Finish burning button, 90
firewall, 132 SSeeee  aallssoo Windows Firewall
first-party cookie, 363
Fit picture to frame, 206
Flickr, 192
Floppy disk, 53
FM radio, play in Windows Media Center,

237
Folder Options dialog box, 69
Folders list, categories, 60

viewing, 60
folders, 47 SSeeee  aallssoo email; encrypt; files;

Public folders; sharing
backing up with File History, 462-463
contacts, 58
contents, arranging, 84
contents, managing, 85
copying and moving, 76
creating shortcuts to, 92
deleting and restoring, 78
desktop, 58
display information, 448
downloads, 58
favorites, 58
frequently used, 51
hiding, 81
links, 58
list, expand, 62
managing in network environment, 378
managing, 47

managing, 74
moving quickly between, 52
opening and switching between, 55
options in Navigation pane, 62
options, changing, 82
personal files (Documents, Music,

Pictures, and Videos), 58
protecting, 337
restoring with File History, 464
restoring, 79
Saved Games, 58
Searches, 58
sending, 77
share or unshare, 87
share with a homegroup, 407
sort by headings, 63
template, applying, 85
uncompress, 89
view, change, 83
view, default, 82

fonts
changing, 276
measuring in points, 276
working with, 319

Food & Drink app, 248
formatting

date, time, currency & numbers, 318
disk, 446
email message, 166
photos, 206
text, 276

forwarding email, 169
Found New Hardware wizard, 473
fragmented file, 452
FTP (File Transfer Protocol) site, 400

G
Games SSeeee  aallssoo Media Center

player, customize, 263
app, using, 263

GB (gigabyte), 448
General settings, change, 302
gesture, 4
Get directions, Maps app, 251
Go home, browser, 110
Google, 148, 158, 160. SSeeee  aallssoo People app
graphical user interface (GUI), 1
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graphics
creating in Paint, 200
format, 214 

groups/grouping
collapse or expand, 65
files and folders, 65
Group By button, 56, 64
group/ungroup tabs, 109
grouping apps on Start screen, 42, 43
move Groups to another location, 43
remove Group by option, 65

guest account, 336, 344

H
handwriting journal entries, 293
hardware, 471. SSeeee  aallssoo Device Manager;

drivers; modems; tablets
classes, 477
Device Installation Settings, 478
device, 471, 474
legacy device, 490
minimum requirements, 512
remove a device, 490
removing plug and play, 491
software compatibility, 512

HD-DVD (High Density Digital Video Disc),
53

Health & Fitness app, 249
Help and support, 19

accessing, 9
for Windows, 18
home, 19
how to search, 19

Help+tips app, 3, 522
hibernate mode, 22
hide files and folders, 81
hierarchy, view files, 60
High Contrast Theme, 306, 328
history 

clearing, 119
list, 66
settings, changing 119
viewing and maintaining, 118

hits, 122
home media streaming, 230. SSeeee  aallssoo

Media Center
home page, changing in IE, 105

Homegroup
creating a, 404
sharing options, set, 404, 405
view files in a, 406

hot plugging, 421
Hotmail, 136, 138, 140, 148, 158, 160. SSeeee

aallssoo People app
HTM background file, 213
HTTP (Hypertext Transfer Protocol), 161
hyperlinks, 93 See links

I
Icons

align to grid, 309
change desktop, 308
descriptions, 53
displaying or hiding, 11
hide or show, 323
resize desktop, 309
show or hide common system, 322
view pictures as icons, 205
view, 49, 82

Icons View button, 49
ICS (Internet Connection Sharing), 402
ID, digital, 362
identify computers on a network, 382
images

capture with Snipping Tool, 290
modify in Paint, 202
understand bit depth, 214

IMAP (Internet Message Access Protocol),
161

IME (Input Method Editor), 316
import pictures & videos, 210
importing photos, 194
inbox, email, overcrowded, 172
incoming network connection, 377
indents, setting, 278
index

encrypted files, 71
modifying to improve search, 70
Restore Defaults, 71
Settings tab, 71

indexed locations, managing, 70
indexing new content, pausing, 70
Indexing options, Control Panel, 70-71
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information
find in Event Viewer, 498
inserting and editing, 282
linking and updating, 284
sharing among programs, 285

ink-jet printer, 418
InPrivate browsing, 108
InPrivate browsing, disable toolbar & 

extensions for, 370
InPrivate browsing, IE app, 98, 99
InPrivate browsing, block content with, 370
input language, 316
insert a special character, 281
insert and delete text, 274
insertion point blink rate, adjust, 479
install 

apps from the store, 36
digital camera or scanner, 209
fonts, 319
hardware device, 476
modem, 433
printer driver, 420
program, 456
Windows 8.1, 514-515

on USB drive, 519
preparing to, 512

Windows Live Essentials, 176
installing/uninstalling. SSeeee  aallssoo download-

ing
instant message, 177 

exchanging, 177
settings, 46

Internet, 93. SSeeee  aallssoo certificates; cookies;
downloading; URLs; web pages

connection, creating, 133
files, clean up, 366
identity, protecting, 368
privacy options, 367
security zone, 364

Internet Connection Sharing (ICS), 402
Internet Explorer (IE)

access e-mail, 129
Adaptive Page Zoom tools, 113
add accelerators, 114
browse with protected mode, 103
change home page, 105
downloads, viewing, 94

download a file from a web page, 130
home page, 102
on taskbar, 12
print web page, 124, 125
protected mode, browsing with, 103
reading view, 96, 102
reset settings, 121
save a web page, 128
save picture from web page, 126
share information with others, 126
sharing information from, 34
starting from desktop, 103
Suggested Sites, 115
switching to, 59, 94
tabs, using, 98-99
tile, 97, 99
use AutoComplete to search, 106
version 10, 94
view downloads, 131
view window, 104

Internet Explorer app, 94
App bar, 30-31
change settings, 102
Charms bar, 100, 102
create new tab, 98
find info on web page, 101
finding information, 100
InPrivate browsing, 98
navigate privately, 99
navigate using tabs, 98
using, 96
window, 94-95

Internet Service Provider (ISP), 133
iPod, 228
ISP (Internet Service Provider), 133
Items in list, 35

J
joining

domain network, 386, 387
homegroup, 404, 405, 406
workgroup network, 384

journal entries, handwriting, 293
Journal Note Writer printer driver, 293
JPEG (Joint Photograph Experts Group),

214
background file, 213
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Jump List
accessing, 12
pin, unpin, remove items, 270
remove recently used documents, 273

Junk folder, 168. SSeeee  aallssoo email

K
KB (kilobyte), 448
keep files in sync, 408
keyboard

settings, change, 479
shortcut, 16
Touch screen, 12-13

keywords, 122

L
LAN (local area network), 376

disable, 398
Language bar or icon, 316, 317
language

change options, 316
Finance app, change, 242
News app, change, 241
preferences, 302
Sports app, change, 245

laptop, Windows Mobility Center, 485
laser printer, 418
layouts

customize, 61
elements, show or hide, 61
on View tab, 50

LCD (Liquid Crystal Displays), 311
Libraries, 48. SSeeee  aallssoo Media Player

back up copy, 462-464
creating new, 57
default settings, restoring, 84
delete playlist, 225
deleting files from, 223
File Explorer, 47
folders, customizing, 84
include or remove folders, 57
show/hide, 61
working with, 56

Like a USB flash drive option, 91
line spacing, set exact numbers for, 278

links/linking, 93. SSeeee  aallssoo hyperlinks; 
shortcuts

add, 62
contact, 147
dialog box, 285
file, update, 285
linking, defined, 284-285
move, 62
object between programs, 284
object, finding, changing & breaking, 285
on taskbar, 13
part of a file, 284
remove, 62
rename, 62
restore default, 62
update manually, 285

LinkedIn, 136, 138, 140. SSeeee  aallssoo People app
emails with Mail app, 159, 162-163

List box, 17
list of apps, shorten, 45
List view, 49, 82
listen to music, 264-265
Live File System Format, 91
live preview, 49-50
local account, 338
Local disk, 52-53
Local Intranet security zone, 364
local printer, 419
Local Users and Groups tool, 508
locating files, 70
locations

changing current, 59
common, 59
denying location requests, 367
my current, 46, 266
navigating to, 59
privacy settings, 46, 266
switching between, 59
typing in, 59

Lock screen, 3, 44, 199
locking/unlocking, 351
personalize, 299
using without unlocking, 21

Lock the taskbar, 321
locking the computer, 351
logon security, change on workgroup 

network, 346
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M
MAC (Media Access Control), 393
macro virus checking, 361
Magnifier, 203, 328
mail SSeeee  aallssoo contacts; email; People app
Mail app

adding accounts, 160-161
account settings, 162-163
attachments, 170
check spelling, 165
compose and send email, 164-165
conversations, 170-171
creating email signatures, 167
deleting/sweeping email, 174
download a file in an email, 171
favorites, 172-173
formatting email messages, 166
forward an email, 169
introduction to, 157 
junk/not junk, 174
managing email, 172-173
message flags, 168
messages, send and retrieve, 160
modify account settings, 162-163
move emails to a folder, 172
newsletter emails, 159, 162-163
open or save files in email, 171
reading and replying to email, 168-169
searching for email, 175 
sending and retrieving a file, 170
servers supported by Mail app, 161
social media emails, 159, 162-163
starting, 158 
viewing window, 159 
work on draft email, 164-165

maintaining your computer, 443
make files available offline, 411
malicious attacks, avoiding, 360
managing

all printers, 500
browser add-ons, 373
color, 484
contact information, 135, 136
desktop windows, 14
event log, 498
files and folders in network, 378
files and folders, 47, 54

files using a CD or DVD, 90
hardware, 471
local users and groups, 508
offline files, 411
outgoing faxes, 438
printers and print jobs, 426
storage spaces, 483
user accounts, 349
wireless connection, 396

manually
connect to wireless network, 393
update a link, 285

Map network drive button, 399
MAPS (Microsoft Active Protection Service),

354
Maps app, 46, 250-251

set privacy options, 46, 266
using, 250-251

Mark unread button (email), 168
Mastered format, 90
Math Input Panel, 294
MathML (Mathematical Markup Language),

294
Maximize active window, 14
Maximize button, 15
MB (megabyte), 448
measurement system, (U.S. or metric), 318
Media Access Control (MAC), 393
Media Center See Windows Media Center
Media Player SSeeee  aallssoo CD, DVD

access updates, 216
change look, 229
add media files from hard disk, 225
add music files to playlist, 233
adding functionality to, 232
browse media files, 222
changing look, 229
copy music to a CD, 228
create playlist, 224
enhancing player display, 232
play a DVD or VCD movie, 219
play audio CD, 218
play media files from a playlist, 223
play media files from the Library, 223
play media streamed to or from another

computer, 231
playing licensed files, 227
playing media files, 222
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play shared, 407
related apps, about, 239
rip tracks from music CD, 226
start & update, 216
stream from shared, 406
streaming media, 230
trouble hearing sound, 221
viewing window, 217

Media Usage Rights tab, 227
Medium icons, 205
Memory Diagnostic tool, 501
memory (RAM)

device low on, 29
managing, 29
problems, 501

menus, 16
command from shortcut menu, 51

Messenger service, 188-189
Metro Apps, 23, 28
Microsoft account

messaging, in Skype, 178
settings, 338
viewing info, 37

Microsoft Active Protection Service (MAPS),
354

Microsoft Bing search engine, 100
Microsoft Deployment Toolkit, 519
Microsoft Disk Operating System (MS-

DOS), 288
Microsoft help and support, 18
Microsoft Internet Explorer (IE), 93
Microsoft Network (MSN) web site, 105
Microsoft Windows Update website, 478
Minimize button, 15, 413
Minimize the Ribbon button, 50
minimize windows, 12
mobile devices, 485

stylus pen for, 4
modems

change settings, 482
install, 433
using to connect to a network, 388

modify
app switching options, 32
backup settings, File History, 462-463
network and sharing options, 380
picture in Paint, 202

monitor
add secondary, 486-487
screen resolution, 312-313
using multiple, 486-487

Monitor tab, 312
monitoring

activities, 497
local security settings, 504

mouse, 4
Mouse properties, 480
move

emails to a folder, 172 
file or folder with Drag and Drop, 77
file or folder, 76
group, 43
link, 62
text, 275
window, 14

Move To/Move Here, 76-77
movies, making with Windows Live Movie

Maker, 176, 195
MP3 format, 227
MS XPS Document Writer, 431
MS-DOS (Microsoft Disk Operating

System), 288
multi-function device, 418
multiple apps, working with, 32
Multiple displays button, 486-487
Music app

using, 264-265
playlists, 265

music CD, play, 218
Music SSeeee  aallssoo CDs; Media Center

folder, 47, 233
folder, Play All, 85
library folder, 56
listening to with Music app, 264-265
tasks, specialized, 233
tools, 233

mute icon, 220

N
name

change for workgroup network, 385
privacy settings, 46

Name group button, 43
Narrator, 327-328, 330-331, 334
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navigating
basics, 110
between folders, 59
dialog box, 17
Photos app, 193

Navigation pane, 48, 54
about, 61, 62
customize, 62
favorites, 62
folder options, 62
folders list, 60
show or hide library, 84

NetStumbler, 393
Network and Sharing Center, 375, 380, 390,

394
set share options, 403

Network button, 381
Network folder in File Explorer, 378
Networks panel, 381

manage wireless connection, 396
networks, 375. SSeeee  aallssoo Mobility Center;

Network and Sharing Center; remote
computers; wireless networks

adapter, 386
administrators, 493-494
connections, 377, 381
diagnostics, 383
discovery, 380
drive, mapping, 399
hub, 376
icon, 381, 389, 392
ID, 384, 387
printer, 419
resources, find, 378
troubleshoot, 381
viewing connection properties, 383
with Windows Firewall, 381

New Fax button/New Fax window, 436
New item button, 92
New Tab page, 108
News app, 240-241
newsletter email, 159, 162-163
NICs (network interface cards), 376
non responsive program, ending, 296
non-indexed files, searching, 66, 69
notification area, 10

customize, 11, 322-323

notifications
options, setting for apps, 44
printer, 427

NTFS file system, 337, 444, 445, 446
creating system image, 465
partitioning disk, 507

O
Object Properties dialog box, 285
objects, 282-285. SSeeee  aallssoo embedding

edit or resize, 283
link between programs, 284

ODT (OpenDocument text), 280
offline files

manage, 411
working with, 410

OLE (object linking and embedding), 285
online

account, reset password for, 350
help and support, 18
media, working with, 239
status, changing in Skype, 180, 186

On-Screen Keyboard, 328
Open button, 204
opening

computer, 52
document & program simultaneously, 68
document with different program, 55
documents, 54
email, 168
existing document from within a 

program, 273
files in an email, 171 
folders, 55
library, 56
multiple windows or programs, 14
personal folder, 58
recent document from File tab or

taskbar, 273
Open Office XML document (DOCX), 280
Open Source button, 285
Open With command and menu, 55
Open, apps and accessories, 40
OpenDocument text (ODT), 280
operating system, 1
optimizing

disk, 452
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Options button, 17, 69
options, accessing using Ribbon, 48
order photo prints from web, 207
other properties, advanced search, 67
outline

in Paint, 200
font, 319

Outlook, 136, 138, 140, 148, 158, 160. SSeeee
aallssoo People app

P
padlock icon, 364
page format, setting up, 125
page setup, 272, 429. SSeeee  aallssoo documents;

Web pages
pages per minute (ppm), 418
Paint

modify a picture, 202
saving pictures, 201
tools, 200, 202
use to create background design, 213
using Windows accessory, 200
Windows accessory program, 191

Pane, defined, 16
go to previous, 31
how to dismiss, 30 

Panes group on View tab, 61
paragraph

indents, change, 278
tabs, setting, 277

partial matches, advanced search, 67
password

change policy, 505
change, 348-349
create a picture, 348
create complex, 504
for homegroup, 404, 406
optimum length, 3
picture, 3
reset, 350
switch to, 3
sync, 301

Password policy folder, 505
Password Reset disk, 350
Paste Special, 283, 284
pause printing, 426, 427
payment method, adding, 37

PC settings
change, 32
check for updates, 458-461
customize Windows 8.1, 298
General, 303
install updates from, 516, 517
screen, 338
update Windows manually, 458-461

PDF (Portable Document Format), 253, 431
peer-to-peer networking, 377, 384
People app, 135-137, 157

adding or editing contacts, 144
creating favorite contacts, 143
deleting contacts, 146
instant messages, 177, 180
linking contacts, 147
pinning to Start screen, 145
managing online accounts, 138-139
sorting or filtering contacts, 142
viewing contacts, 140-141

People tile on the Start screen, 145
performance

charts, 502, 503
objects, 502

Permanently delete command, 78
permission settings, managing, 87
personal

certificate, 362
folders, working with, 58

Personal Identification Number (PIN code),
348

personalize
desktop, 53, 308, 306
Lock screen, 299
Start screen, 300
user accounts, 335

phishing
email scam, 361, 370
report website for, 371

Phone and Modem properties, 482
phone calls, making in Skype, 186-187
phone dialing options, customize, 482
Photo Gallery, 176
photos 

capture with Camera app, 260
deleting, 195
email, 208
format & print, 206
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pphhoottooss  ((ccoonnttiinnuueedd))
importing, 194
managing with Windows Live Photo

Gallery, 195
prints, order from web, 207
set resolution, 206
working with, 191

Photos app, 191
change options, 192
editing photos, 196-197
deleting photos, 195
displaying slide show, 198
import files using, 210
importing photos, 194
navigating, 193
set photo as tile, 199
starting, 192
using Open button, 204

Pick Color tool, 202
picture password, 3, 348
Picture size list, 208
Picture tools, manage, 205
pictures SSeeee  aallssoo Media Center; Movie

Maker; Paint; Photo Gallery
adding text, 201
change on user account, 347
create custom folder for, 212
creating in Paint, 200
email a, 208
erase part of, 203
fill part of, 203
fit to frame, 206
modify in Paint, 202
resize icons, 205
save in Paint, 201
sharing, 34
using as screen saver, 212
view as icons, 205
viewing, 204

Pictures folder, 47, 204
Slide Show, 85
using, 191

Pictures library folder, 56, 260
Pictures library, 191, 195, 305
PIN (Personal Identification Number) code,

348
pin or unpin a program or items on taskbar,

or to Start button, 40

on a jump list, on the taskbar, 270
Pin the Favorites Center button, 117
ping to find IP address, 289
pixels, 214
Plain Text Document (TXT), 280
play SSeeee  aallssoo Media Center

media files, 215
notification sounds, 44
shared media, 407
sound & video files, 222

Play button, 233
Play audio CD (Windows Media Player), 218
Play on Xbox 360 button, 262
Play tab, 233
Play To button, 231
Player library, accessing or modifying, 231
player profile, edit, 263
playing games, 263
playlist SSeeee  aallssoo Media Center

add media files from hard disk, 225, 264
create, 224, 264-265
delete, 225, 264-265
edit, 225, 264-265
play media files from, 223, 264-265

plug and play hardware, removing, 491
Plug and play technology, 471-473
plug-ins

using (WMP), 231
visualizations, 232

PNG (Portable Network Graphics), 214
pointer, 4-5

change options, 481
pointing devices, 4
POP3 (Post Office Protocol), 161
Pop-up, 44

Blocker, 361, 369
portable devices, find compatible, 229
Power button, set options, 489
power plan, 488
powering down, 22
power user menu, 21
ppm (pages per minute), 418
presentations, folders for, 47
preview and print a document, 279
preview in Windows Photo Viewer, 204
Preview pane, 61
Print dialog box, 17, 424-425
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Print management tool, 500
Print Preview, 279
print queue, 426
printers

2D or 3D, 418
device & spooling properties, 428
installing, 420-421, 425
manage all, 500
menu, 426
notification, with Windows Firewall, 427
preferences, changing, 429
quickly delete, 490
rename or delete, 423
resolution, 418
sharing a, 430
speed, 418
TCP/IP address, 420
types of, 418
viewing properties, 419

printing
2-D or 3-D, 418, 420, 458-461
default printer, setting, 422
documents, 279, 458-461
faxes, 417
pause and resume, 426
photos, 206
preferences, 429
spooling, 428
web pages, 125

privacy
enhancing with TPL, 372
maintaining, 40, 41
protecting on Internet, 367
settings, 46
settings for apps, 46, 183, 266

Processes tab, view app performance, 502
product key, Windows 8.1, 512-513
Program Compatibility troubleshooter, 295
Program tab, 50
programs, 1. SSeeee  aallssoo apps

change a file type or protocol, 325
changing the way it starts, 270
descriptions, 271
installing or uninstalling, 456
not responding, 296
running older, 295
set access, 325

setting default, 324
switching among open, 12
work with several at once, 271

Programs and Features utility, 455
Properties button, 448, 449, 454
properties SSeeee  aallssoo Control Panel

add or modify, 72
of drive or device, 53
on Taskbar, 13
remove, 73

protecting
against phishing, 370
device with firewall, 132
Internet identity, 368
Internet privacy, 367

protocol, 161
network connection, 383

Public folder, using to share files, 86
publisher certificate, 362

Q
Quick Access Toolbar, 48, 51
quick tip, Using Ease of Access from Sign in

Screen, 328
quotas, set disk, 449

R
RAM (Random Access Memory), 29, 448,

454 SSeeee  aallssoo memory
rating files with stars, 72
Read/Write, sharing permission, 87
Reading List app, 252
Reader app, 28, 253, 431
ReadyBoost, 454
receive a fax, 439
Recent Searches button, 68
recognizing your speech, 332
record

series of actions, 291
sound, 234-235

recovery and startup options, set, 469
Recycle Bin, 78-79

sound effect for, 236
refresh

browser, 110
Windows 8.1 operating system without

affecting files, 303, 517
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regional options, change, 318
Registry, change settings, 501
reinstall 

apps, 37
Windows 8.1 operating system, 302-303

reinstall Windows 8.1, 298, 518
reminders for events, 153 SSeeee  aallssoo

Calendar
remote computer, connect, 412-413
Remote Media Streaming, 215
RemoteApp, 413
Removable disk, 53
remove

device, 475
everything and restart Windows, 517
hardware device, 490
link, 62
Windows components, 455
Windows 8.1 operating system, 302-303

Remove Device button, 423
Remove permission setting, 87
Remove properties, 73
rename

link, 62
printer, 423
files and folders, 74, 75

Rename button, 92
Repair button, 457
repair software program, 457
reply to email, 169
report

unsafe website, 371
Easy Transfer, 521

reset
all defaults, 326
password, 350
Windows 8.1 operating system, 302-303

Reset Folders, 83
Resize

app tiles, 42
buttons, 15
columns, 65
windows, 14-15

Resolution button, 312-313
resources, share, 376, 377
restart, 22   
restore SSeeee  aallssoo system protection,

advanced system settings

backup files, File History, 462-464
computer settings, 466
default links, 62
file or folder using File History, 464
files and folders, 79
open windows, 15

Restore Defaults, 82, 84-85
Restore Down button, 15, 413
restore point, 466

create, 467
Restricted Sites security zone, 364

add and remove sites, 365
restrictions, Windows Store & games, 357
resume printing, 426
retouch photo, Photos app, 196-197
rewritable disk, erasing, 447
Ribbon, 50

accessing buttons or options, 48
using to create document, 272

rich text format (RTF), 280
right-clicking, 4-5
Rip CD command, 226
rip music, 227
Rip settings button, 226, 227
rotate photo, Photos app, 196
router, wireless, 394
RSS (Really Simple Syndication) feed, 120
RTF (rich text format), 280
Ruler check box, 277
running

commands, 288
older programs, 295

S
Safety Menu, 370
Save draft button (email), 165
Save Location button, 57
Save my searches, 45
saved searches, 68

moving to Favorites, 68
saving SSeeee  aallssoo Movie Maker; web pages

documents, 280
picture from a web page, 126
search, 68
space, compress file contents, 89

scalable or outline font, 319
Scan app, 209, 442
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scan and fax a document, 437
scanner, install, 209
schedule

a new event, 150, 151
a recurring event, 152
an event with a reminder, 153

Schedule button, 409
scheduling tasks, 496
Screen Resolution dialog box, 486-487
screen resolution, 312-313
Screen Saver list, 212
screen saver, using, 310
screen scaling options, 311
screen shot, capture, 290
ScreenTip, 4
scroll bars, 4
Scrolling, 29
Search Again In button, 67
Search Box/Search Button/Search tab SSeeee

aallssoo searching
box, 26, 48, 100
button, 26, 27, 45
how to close, 26
how to use, 66
setting search options for apps, 45
tab, 69

search engine results, 122
Search panel, 100

accessing, 26
searching for email, 175

search providers, add or change, 123
Search Results 

folder, 66
narrowing results, 26

searching
change options, 69
create simple, 66
find partial matches, 69
for apps, 26
for email, 175
for files and folders, 66
improving by modifying index, 70
recent searches button, 68
saving a, 68
the web, 122
using an app, 27

secondary monitor options, 486-487
securing a computer, 336

security SSeeee  aallssoo Internet Explorer; email;
passwords; phishing

changes, making, 341
for remote computer, 412
icons and descriptions, 353
Local Users and Groups, 508
maintaining, 335
monitor local settings, 504
on the Internet, 362
options, reset default settings, 365
options, setting, 504
passwords or codes, use multiple, 348
properties, display, 397
related events, monitor or audit, 504
settings, view in Action Center, 352
tool NetStumbler, 393
zones and levels, 362, 364, 365

security alert
acting upon, 353
displaying printer notification, 427
locking down wireless network, 393
working smarter as the administrator,

349
Security Status bar, display info, 371
select a file system, 445
Select and Correct button, 294
Send To command on shortcut menu, 77
sending

faxes, 436
files and folders, 77

Separation bar
positioning, 33
snap an app to, 33

server, 376
service type, network connection, 383
Services and Applications, 506
Set as the default printer check box, 421
set up

detected printer, 420
fax, 433
File History, 462-463
non-detected printer, 421
remote computer, 412
Windows Firewall, 134
wireless network, 394

setting
AutoPlay options, 326
compatibility for an older program, 295
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sseettttiinngg  ((ccoonnttiinnuueedd))
date and time, 314
default programs, 324
disk quotas for users, 449
Ease of Access options, 334
Family Safety controls, 356-357
network sharing options, 403
paragraph tabs and indents, 277-278
privacy options for apps, 46
program access and defaults, 325
search options for apps, 45
search provider options, 123
Speech Recognition options, 333
system protection, 466

Settings button, 9, 31, 303, 495
Settings panel 

network icon, 388, 390-392
volume control, 220

Share button, 9, 34
Share button, 9
sharing SSeeee  aallssoo domain networks; embed-

ding; Network and Sharing Center;
networks; printers 

between apps, 34
files and folders with homegroup, 

406-407
files and folders, 86 
files with SkyDrive, 256
folder, 87
information among programs, 282-285
information, 35
Internet connection, 402
options, setting, 403
printer, 419, 430
reading list, 252
settings, change, 35
Work Folders with, 414-415

Share this printer check box, 430
shared folder, view, 379
shareware virus checking programs, 361
Shortcut menu, 4, 51
shortcuts

placing on Desktop or Taskbar, 92
to files and folders, 92
to network, 400
using KeyTips, 50

show
administrative tools, 41

all folders, 62, 82
all locations, 70
app notifications, 44
hidden files and folders, 81
task manager, 13
traffic, Maps app, 250-251
windows side-by-side, 15
windows stacked, 13, 15

Show Desktop button, 11, 15
Show Hidden Icons button, 323
Show recycle confirmation command, 78
Shuffle pictures check box, 212
Shutting down device, 22
Side-by-side view of windows, 15
Sign in screen, 3
Sign Out and Sign In, 21, 22
sites, safe file repositories, 361
size See resize 
Skin Chooser (WMP), 229
SkyDrive, 170, 176, 239

app, 191, 192, 254-257
download files to device, 256
make back up copy, 462-464
managing files with, 254
online/offline, making, 256
photos, 195
settings, changing, 258
sharing files with, 256
syncing, 301
upload files to, 257
using with Photos app, 191, 192
using, 254-255

Skype app, 46
accounts settings, 180-181
changing options and privacy, 182-183
changing status, 180, 186
contacts, 184-185, 190
conversations, 188-189
File Explorer, 48, 56, 58, 60
help, online, 183
introduction, 177
invite others to IM, 188-189
making phone calls, 186-187
profile settings, 180
send and receive IMs, 188-189
service, Skype, 188-189
sharing, 86-87
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sign in and out, 178
start new IM, 188
starting, 178
viewing the window, 179

Sleep mode, 22 SSeeee  aallssoo Power Plan
Slide show button, 205
slide show

control speed, 205
displaying, 198
shuffle, 212

SmartScreen Filter on Safety menu, 370
SMS (Short Message Service), 188-189
SMTP (Simple Mail Transfer Protocol), 161
Snap feature, 33
snap-in tools, stand alone or extension, 506
Snipping Tool, using, 290
social media accounts, 136
social media email, 159, 162-163
software SSeeee  aallssoo drivers; web browser

antivirus software, 130-131, 171, 360
installing and uninstalling, 456-457
repair program, 457

songs, remove from list, 218
sort a column, 63
Sort By button, 56, 64
sort desktop items, 309
sorting 

contacts, 142
files and folders, 64-65
to organize files, 63

sound files, 
create your own scheme, 236
download & play, 222
record, 234-235

Sound Recorder, 215, 234-235
Sounds tab, 236
source file or program, defined, 282-285
SP (Service Pack), install, 516
spam, 361
special character, insert, 281
specialized information apps, 243
specify a default printer, 422
Speech Recognition button, 333
Speech recognition icon, 330, 332, 333
Speech Recognition, set options, 333
speed, boost, 454
spooling, 428

Sports app, 243, 244-245
Spreadsheets, folders for, 47
Spyware

in add-ons, 373
protect against, 354, 361
thwarting, 346

SSID (Service Set Identifier), 392, 393
stacked view of windows, 15
standard account, 336
standard tab, 50
Start bar, 6

using, 8
using to switch apps, 32

Start button, 8-10, 12
Start menu, accessing folders, 58
Start Recording button, 234-235, 291
Start screen

apps available on, 23
change volume from, 220
change, 346
customizing, 40
default metro apps, 28
features and descriptions, 6-7
navigation options, 7, 307
personalize the, 300
settings, change, 41
starting Windows 8.1, 3
start up, desktop/Start screen, 7, 307
switching between recently used apps, 8
thumbnail, 8
tile, 44
using to access Apps view screen, 24
with Skype app, 178

Start settings panel, 40
start

Windows when problems occur, 470
startup, desktop/Start screen, 7, 12, 307
Startup and recovery options, set, 469
Startup Repair

system recovery drive, 468
use to fix problems, 470

Status bar, 48-49
stay signed in by locking screen, 20
Steps Recorder, using, 291
StickyKeys, 328
Sticky Notes program, 292
Stop Recording button, 234-235, 291
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stopwatch, 259
Storage Spaces utility, 483
Storage, Computer Management, 506
storage, available, 303
Store screen, returning to, 37
Store tile, 37
Store, uninstall apps from, 39
stored files, finding, 66
Stream button, 230
streaming media, 230
streaming, problems with, 231
subfolder, apply template to, 85
Suggested Sites, 115
support, 18

technician, information for, 509
contact, 19

swiping, 4-5
Switch to library button, 232
Switch to Now Playing button, 232
Switch to password, 3
switching 

among open windows, 14
between folders, 55
between views, 49
to local account, 338
users, 20, 

Sync button (email), 168
Sync Center, 408-410
sync 

all offline files, 409
individual offline files, 409
options, 229
options with other devices, 301
passwords, 301
source and destination files, 284
start/stop, 229
with a device, 408

system
Computer Management window, 506
configuration options, set, 510
directory, searching, 69
files, advanced search, 67
image, create, 465
information (basic), 3, 53, 382, 509
information for support technician, 509
protection, set, 466
recovery drive, create, 468

tool start/tool exit, 268-269
System Configuration tool, 510
System Image Recovery

system recovery drive, 468
System properties button, 382, 384-385
System Restore, 466-467

system recovery drive, 468

T
tablets, 1. SSeeee  aallssoo Device Manager; 

hardware
handwriting, 293
multi-touch, 512
screen rotation, 485
secure entry point for, 2
using mouse, gestures, stylus pen, 4

tabs, 16-17
group or ungroup, 109
options, set, 109
set exact numbers for, 278
stop, create and clear, 277

Tabs on the Ribbon, 50
tags, adding, 72
Take Speech Tutorial, 332
tap-hold, taskbar buttons, 270
tapping, 4-5
Task manager

show, 13
using, 296
view performance information, 502

task not responding, 296
Task Scheduler, 496
Taskbar, 10, 12 SSeeee  aallssoo Notification area

customizing, 11, 13, 322
default programs pinned to, 12
location on screen button, 322
locking and unlocking, 13, 321
moving, 321
pin to or unpin from, 12, 40

Taskbar Properties dialog box, 320
tech support, 509
template, applying a folder, 85
text SSeeee  aallssoo document

add to picture, 201
boxes, 17

using in Paint, 200-201
document, open in WordPad, 55
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editing, 274
find on web page, 123
folders for files, 47
formatting, 276
insert and delete, 274
move or copy, 275
sharing, 34
tab, 201
tool, 201
wrapping options, 277

text-based interface (command line), 267
Text-to-Speech (TTS) options, 330. 
Theme list for desktops, 306
third-party 

content, blocking, inPrivate, 370
cookie, 363

This PC, 52, 56, 60
3-D printing, 418, 420, 458-461
thumbnail, 49

live, 14
TIF (Tagged Image File Format), 214
Tile groups, changing name, 42
tiles, 6-7

arrange in groups, 42
clearing information on, 41
command, using, 28
information, clearing, 28
on Start screen, 28
scrolling to display, 29

Tiles view, 49, 82
Time Zone Settings dialog box, 314
time, keeping accurate, 315
timer, 259
TMP (Trusted Platform Module), 359
tombstoned, closing apps, 29
Toolbar, 16

displaying and arranging, 320
on the taskbar, 320
resize, expand or collapse, 321
show or hide, 13
using, 16

touch pad, 4
Touch screen keyboard, from taskbar, 12-13
TPL (Tracking Protection Lists), 372
trackballs, 4
Train your computer to better understand

you, 332

transferring files and settings
to the new system, 521
from another computer, 520

Travel app, 243
Trojan Horse, 360
Troubleshoot button, 474
troubleshoot

computer problems, 492
copying text from web page, 127
help with user names, 412
no photos available, 195
search non-indexed files, 66
sharing app not available, 34
slider not available to select security

level, 364
snapping app to Separation bar, 33
testing your sound hardware, 221

troubleshooting wizard, 492
Trusted Sites security zone, 364
TSID (Transmitting Station Identifier), 441
TTS (Text-to-Speech), 330
Turn live tile off or on, 41-42
Turn off device, 22 SSeeee  aallssoo powering down
TV

add to Windows Media Center, 215
streaming, 230
watch in Windows Media Center, 237-238

Twitter, 136, 138, 149. SSeeee  aallssoo People app
emails with Mail app, 159, 162-163

2-D printing, 418, 420, 458-461
TXT (Plain Text Document), 280
typeface, 319. SSeeee  aallssoo font
typical disk drives on a computer, 53

U
UAC (User Account Control), 336, 341

change policies, 504
uncompress files and folders, 89
understanding 

disk file systems, 444
faxes, 432
file extensions, 83
file formats, 214
network services, 376
plug and play hardware, 472, 473
printers, 418

unhide files and folders, 81
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uninstalling
apps, 39
programs, 456, 457
Windows 8.1 Service Pack, 517

Unpin from Start button, 40
unpin or pin a program or items on taskbar,

270. SSeeee  aallssoo customizing apps on
the Start Screen, 40-41

unshare folder, 87
updates, enable automatic, 337
updating

apps, 38
linked file, 285
to a Windows Service Pack, 516
Windows, 458-461

upgrade
from previous version of Windows, 511
in-place or install new copy, 513

upload files to the SkyDrive, 257
URL (web address), 106-107
USB (Universal Serial Bus), 376
USB drive, install Windows, 519
USB ports, understanding, 421
Use AutoPlay for all media & devices check

box, 326
User account, 6-7

changing type, 345
create, 336, 340
deleting, 342, 343
managing, 37
options, changing, 20

username (account), 3
Users

managing multiple, 20
switching, 20

V
VCD movies, 219
VCR commands, 237
video

capture a, 261
capture with Camera app, 260
files, download & play, 222
formats supported, 222
phone calls, making in Skype, 186-187
watching with Video app, 262

Video app, 262

Video mode button, 260, 261
Video, Music, and Games app, 243
Videos library folder, 56, 262
View tab

layout options, 49
panes group, 61

viewing
account information, 37
compressed files, 89
Control Panel, 304
documents, 54
feeds, 120
files and folders, 80
files using icons view, 49
folders list, 60
fonts, 319
hardware devices, 474
History List, 118
Internet Explorer window, 104
Mail app window, 159
management tools, 506
music files, 233
network computer properties, 382. SSeeee

aallssoo running commands
network connection properties, 383
network connections, 381
network or workgroup, 378
offline files, 411
online accounts, 138
PC settings, 298
performance chart, 502
personal folders, 58
picture, 204
pictures as Extra large icons, 205
printer properties, 419
resource performance charts, 503
sent fax, 436
shared folder, 379
subscribed feeds, 121
system hardware settings, 477
system information, 509
web page, 106

Views, switching between, 49
virtual memory, changing size, 454
viruses 

preventing, 346
avoiding, 360

Visible folder and subfolder location, 59
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Visualizations, WMP plug-ins, 232
Voice selection list, 330
volume 

adjusting or muting, 11
controlling on devices, 220
icon, display on taskbar, 221
levels, 221
set for recording, 221

volume, storage on disk, 507
VPN (Virtual Private Network), 377, 390-391

disconnect, 398

W
WAN (wide area network), 376
watching videos, 262
WAV format, 227, 236
Weather app, 246-247
weather, view in celsius or fahrenheit, 246
web

addresses (URL), 106-107
navigate with IE app, 97

browser, 93
browsing, 106
feeds, 120-121

web filtering, 357
web pages, 93

add to favorites list, 116
copy text from, 127
navigate with IE app, 96
open favorite in new tab, 99
pin to Start screen, 94
preview and print, 124
save a, 128
saving pictures or text from, 126
send or link by e-mail, 129, SSeeee  aallssoo

sharing between apps, 34
set as background, 127
viewing, 106

web search, IE app, 100
web site, 93 

suggestions, 115
web, 

browsing privately, 111
download files from, 130

WEP (Wired Equivalent Privacy), 393
Wi-Fi (wireless connection), 381, 392-393,

395

Wi-Fi Protected Access (WPA), 393
wildcard character, using to change files,

289
window, 1

identifying by name, 14
making active, 12
maximize active, 14
resizing, 14

Windows 7, apps comparison, 23
Windows 8.1

customizing 297
Edition, 2
Enterprise Edition, 2
installation, system recovery drive, 468
installing, 511
introduction, 2
product key, 512-513
Professional Edition, 2
refresh, remove, or reinstall, 303
reinstall, 298
reinstall, reset, or restart, 517
RT Edition, 2, 520-521
set compatibility for older programs, 295
starting, 3

Windows 8.1 product key info, 512-513
Windows 8.1 Setup wizard, 512, 514-514
Windows 8.1 Upgrade Assistant, 512-513
Windows, show side-by-side, 13
Windows, switching among open, 12
windows, switching among open, 14
Windows 

accessories & system tools, 267
accessories, frequently used, 271
accessory, exit a, 269
accessory, start a, 268
components, adding or removing, 455

Windows Defender
change options, 355
using, 354

Windows Easy Transfer, 520
viewing report, 521

Windows Fax and Scan, 417, 432, 433, 435,
436, 438, 439, 440

Windows Firewall
avoid harmful attacks, 360
enable, 337
printing with, 427
setting up, 134
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settings, change, 380-381
stream block, 231

Windows help and support, 18
Windows Journal, 293
Windows Live Essentials, install, 176
Windows Live Mail, 176, 195

email photo, 208
security, 337, 362, 368

Windows Live Movie Maker, 195
Windows Live Photo Gallery, 195
Windows Media Audio (WMA) format, 227

record audio files, 234-235
Windows Media Center, 215

change settings, 238
Extender, 238
navigating, 237
starting, 237

Windows Media Player, 215-216 See Media
Player

Windows Memory Diagnostic, 501
system recovery drive, 468

Windows Mobility Center, 485
Windows Photo Viewer, 204

format from, 206
manage pictures with, 211
ordering prints from online printing co.
print from, 206

Windows ReadyBoost, 454
Windows Service Pack

update to, 516
uninstall, 517

Windows Store, 36
Windows Task Manager, view performance

charts, 503
Windows Theme, 306
Windows To Go workspace, 519
Windows Update Driver settings, change,

478
Windows Update, 443
Windows 7, transfer files and settings from,

520
Windows, update automatically, 458-461
Windows, update manually, 458-461
wireless (WLAN) 802.11g, 802.11n, 393
wireless connection, 396-397
Wireless devices, turn on or off, 395
wireless network

disable or enable, 395

disconnect, 398
locking down, 393
set up, 394

wma file extension, 234
Word Wrap button, 277
WordPad

default save in RTF, 280
editing text, 274
embed Paint object, 282
opening text document, 55
using, 272

Work Folders, 414-415
workgroup network

change name, 385
join using wizard, 384

Workgroup wizard, 386
workgroup, group of computers, 377-378
Workplace

joining, connecting to, 416
syncing files to, 414-415

workstation, 376
World Wide Web, 93
worm, 360
WPA (Wi-Fi Protected Access), 393
Write button, 294
Writer, 176

X-Z
Xbox Live

accounts, online, 263
emails with Mail app, 159
games, 263
music, 264-265
stream from shared, 406
streaming, 230
videos, 262
Windows Media Center Extender, 238

Xbox SmartGlass app, 263
XML feed, 120
XPS (XML Paper Specification), 431

Reader app, 253
Your apps, 37
Zoom button, 6-7
Zoom in or out buttons 

Maps app, in, 250
Zoom tools and submenu, 113
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